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LIMITED USE LICENSE AGREEMENT 
You should carefully read the following terms and conditions before opening this package. By opening this package 
you are agreeing to become bound by the terms of this agreement and indicating your acceptance of these terms and 
conditions. If you do not agree with them, you should return the package unopened to Geophysical Survey Systems, 
Inc. 

Geophysical Survey Systems, Inc. (GSSI), an OYO Corporation, provides the computer software ("RADAN 6.x") 
contained on the medium in this package, and licenses its use. You assume full responsibility for the selection of 
RADAN 6.x to achieve your intended results and for the installation, use and results obtained from the Program. 

LICENSE 

a) In consideration of the payment of a license fee, you are granted a personal, non-transferable license to use 
RADAN 6.x under the terms stated in this Agreement. You own the diskette or other physical media on which 
RADAN 6.x is provided under this Agreement, but all title and ownership of RADAN 6.x and enclosed related 
documentation "("Documentation"), and all other rights not expressly granted to you under this Agreement, remain 
in Geophysical Survey Systems, Inc.; 

b) RADAN 6.x must be used by you only on a single computer or as a traveling license via use of a USB Hardware 
Security Key; 

c) You and your employees and agents are required to protect the confidentiality of RADAN 6.x. You may not 
distribute or otherwise make RADAN 6.x or Documentation available to any third party; 

d) You may not copy or reproduce RADAN 6.x or Documentation for any purpose except you may make one (1) 
copy of RADAN 6.x if RADAN 6.x is not copy-protected, in machine readable or printed form for backup purposes 
only in support of your use of RADAN 6.x on a single computer. You must reproduce and include the Geophysical 
Survey Systems, Inc. copyright notice on the Backup copy of RADAN 6.x;  

e) Any portion of RADAN 6.x merged into or used in conjunction with another program will continue to be the 
property of GSSI and subject to the terms and conditions of this Agreement. You must reproduce and include the 
copyright notice on any portion merged into or used in conjunction with another program; 

f) You may not sublease, assign, or otherwise transfer RADAN 6.x or this license to any other person without the 
prior written consent of GSSI. Any authorized transferee of RADAN 6.x will be bound by the terms and conditions 
of this Agreement; and 

g) You acknowledge that you are receiving only a Limited License to use RADAN 6.x and Documentation and 
GSSI retains title to RADAN 6.x and Documentation. 

You acknowledge that GSSI has a valuable proprietary interest in RADAN 6.x and Documentation. 

You may not use, copy, modify, or transfer RADAN 6.x or Documentation, or any copy, modification, or merged 
portion, in whole or in part, except as expressly provided for this Agreement. 

If you transfer possession of any copy, modification, or merged portion of RADAN 6.x or Documentation to another 
party, your license is automatically terminated. 

TERM 
The license granted to you is effective until terminated. You may terminate it at any time by returning RADAN 6.x 
and Documentation to GSSI together with all copies, modifications, and merged portions in any form. The license 
will also terminate upon conditions set forth elsewhere in this Agreement or if you fail to comply with any term or 
condition of this Agreement. You agree upon such termination to return RADAN 6.x and Documentation to GSSI 
together with all copies, modifications, and merged portions in any form. Upon termination, GSSI can also enforce 
any rights provided by law. The provisions of this Agreement which protect the proprietary rights of GSSI will 
continue in force after termination. 
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LIMITED WARRANTY 

GSSI warrants as the sole warranty provided to you that theCD on which RADAN 6.x is furnished will be free from 
defects in materials and workmanship under normal use and conditions for a period of ninety (90) days from the date 
of delivery to you as evidenced by a copy of your receipt. No distributor, dealer, or any other entity or person is 
authorized to expand or alter either this warranty or this Agreement; any such representation will not bind GSSI. 

GSSI does not warrant that the functions contained in RADAN 6.x will meet your requirements or that the operation 
of RADAN 6.x will be uninterrupted or error-free. 

Except as stated above in this section, RADAN 6.x and Documentation are provided "as is" without warranty of any 
kind, either express or implied, including but not limited to, the implied warranties of merchantability and fitness for 
a particular purpose. You assume the entire risk as to the quality and performance of the program and 
documentation. Should the program prove defective, you (and not GSSI or any authorized GSSI distributor or 
dealer) assume the entire cost of all necessary servicing, repair, or correction. 

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state. 
Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. 

LIMITATION OF REMEDIES 

GSSI's entire liability and your exclusive remedy will be: 

a) The replacement of any diskette not meeting GSSI's "Limited Warranty" explained above and which is returned to 
GSSI with a copy of your receipt; or 

b) If GSSI is unable to deliver a replacement diskette which conforms to the warranty provided under this 
Agreement, you may terminate this Agreement by returning RADAN 6.x and Documentation to GSSI and your 
license fee will be refunded. 

IMPORTANT: If you must ship RADAN 6.x and Documentation to GSSI, you must prepay shipping and either 
insure RADAN 6.x and Documentation or assume all risk of loss or damage in transit. To replace a defective 
diskette during the ninety (90) day warranty period, if you are returning the medium to GSSI, please send us your 
name and address, the defective medium and a copy of your receipt at the address provided below. 

In no event will GSSI be liable to you for any damages, direct, indirect, incidental, or consequential, including 
damages for any lost profits, lost savings, or other incidental or consequential damages, arising out of the use or 
inability to use RADAN 6.x and Documentation, even if GSSI has been advised of the possibility of such damages, 
or for any claim by any other party. Some states do not allow the limitation or exclusion of liability for incidental or 
consequential damages, so the above limitation or exclusion many not apply to you. In no event will GSSI's liability 
for damages to you or any other person ever exceed the amount of the license fee paid by you to use RADAN 6.x, 
regardless of the form of the claim. 

U.S. GOVERNMENT RESTRICTED RIGHTS 

RADAN 6.x and Documentation are provided with restricted rights. Use, duplications, or disclosure by the U.S. 
Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the Rights in Technical Data and 
Computer Software clause at 252.277-7013. Contract/manufacturer is Geophysical Survey Systems, Inc., 
40 Simon Street, Nashua, NH  03060-3075. 

GENERAL 

This Agreement is governed by the laws of the State of New Hampshire (except federal law governs copyrights and 
registered trademarks). If any provision of this Agreement is deemed invalid by any court having jurisdiction, that 
particular provision will be deemed deleted and will not affect the validity of any other provision of this Agreement. 

Should you have any questions concerning this Agreement, you may contact GSSI by writing Geophysical Survey 
Systems, 40 Simon Street, Nashua, NH 03060-3075 U.S.A. 

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms and 
conditions. You further agree that it is the complete and exclusive statement of the Agreement between you and 
GSSI which supersedes any proposal or prior Agreement, oral or written, and any other communications between us 
relating to the subject matter of this Agreement. 
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Chapter 1: Introduction and Data Collection 
Requirements 

The Bridge Assessment (BA) module in RADAN is a specialized data analysis tool that efficiently 
processes data obtained with GSSI’s air-launched Model 4208, 4108 and 4105 horn antennas and its 
Model 5100, or 5100B antenna over bridge decks for two different applications: 

1. Concrete cover assessment on new bridge decks 

2. Bridge deck condition analysis.  

An ASCII data file containing the desired information (cover thickness or areas of deterioration) is the 
final output following the data processing. This file can then be used to run descriptive statistics or to 
graph change across the area. 

Antennas 
The module can only process data obtained using GSSI’s Model 4208, 4108 and 4105 air-launched horn 
antennas and GSSI’s Model 5100 and 5100B, ground-coupled antenna with a survey wheel.  

Note: The hardware settings listed in this manual must be used during data collection. 

Brief Overview of this Manual 
Chapter 2 – Data collection and processing methodology using ground coupled antennas is described.  

Chapter 3 – Concrete Condition Assessment methodology using the Model 5100(B) antenna is described. 

Chapter 4 – Concrete Condition Assessment methodology using the Horn antennas is described. 

Chapter 5 – EZ Tracker Processing of Horn antenna data is described. 

Chapter 6 – Interactive Interpretation features and options are described in detail. 

Chapter 7 – Constructing contour maps using rebar reflection amplitudes. 

References 

Appendix A – Procedure to follow for using a calibration hole to calculate the propagation velocity for 
concrete cover assessment is summarized. 

Appendix B – List of problems that may be encountered during data processing and the solutions.  

Appendix C – “How-To” quick reference details the procedure for changing the input and output 
directories for *.dzt files and the units used during data display and processing (i.e., meters, inches,  
feet, etc.). 

 



Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 2 



Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 3 

Chapter 2: Data Collection and Processing 
Methodology for Concrete Cover Assessment 
on New Bridge Decks Using Ground Coupled 

Antennas 

Overview 
This section describes data collection for quality assurance (QA) studies on new concrete cover bridge 
decks. This technique is not applicable to asphalt overlaid decks. The goal of this application is to ensure 
that there is adequate concrete cover over the top layer of reinforcing steel. 

Unlike the Bridge Deterioration Mapping application, a Bridge QA project does not require a 3D 
collection. A single representative profile per travel lane is all that is needed. Typically, this profile is 
along the wheel path of the lane opposed to the shoulder. There is one important caveat to this: the data 
must be collected perpendicular to the trend of the top layer of rebar. This means that if the rebar are 
longitudinal, then you must take profiles across the bridge, not along it. 

If a complete map of cover thickness is required, then a 3D file can be collected following the instructions 
given in your SIR System manual. Be sure to configure the data collection settings (Gain, Position, 
Range, Scan and Sample density) as they are described in this guide. Also be sure to orient profile lines 
perpendicular to the trend of the top bars. 

There are a number of steps that must be precisely followed to collect high quality GPR data for the 
purpose of concrete cover assessment. The following sections describe, in detail, all of the steps involved 
in collecting and processing high-quality GPR data. The end result is an ASCII output file containing the 
locations and depths of the topmost rebar in a concrete structure. 

Data Collection 
1 Turn on your SIR System and recall the saved radar setting used for new bridge decks. 

• If no previously saved setting is available, set up the parameters described at the end of this 
chapter.  

2 Let the SIR control unit run in setup mode for a recommended warm-up time of 5-10 minutes 
with the scan showing on the screen.  

• During the warm-up period, it is recommended to physically mark the profile lines on the 
structure over which data will be collected, and to measure the position of these marked lines 
with respect to fixed reference points on the bridge deck. The profile lines should be straight, 
and perpendicular to the trend of the top rebar. 

3 Next, after the 5-10 minute warm-up and just prior to collecting data, check the position and gain 
of the scan in the display window and adjust if necessary.  

• Generally, during warm-up, the scan position will drift upward in the window. The scan 
position and gain should look similar to that shown in Figure 1.  
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Caution: Remember, if a portion of the direct wave is missing during data collection or if the gain is 
too high, the data won’t be processed correctly in RADAN. Figures 2 and 3 illustrate a badly positioned 
scan and a clipped scan, respectively. 

 
Figure 1: Typical waveform shape with antenna positioned over rebar. The signal is set up so that the direct wave 

and the peak amplitudes are well within the boundaries of the sampling window. 

 
Figure 2: Badly positioned waveform. The direct wave is not located in the window. Using the signal positioned 

as shown in this figure would cause the program to give erroneous results. Prior to collecting data the user must 
manually adjust the signal position until the direct coupling is located entirely in the window (see Figure 1).  

 
Figure 3: Example of clipped waveform (gain set much too high). Clipping must be prevented for accurate rebar 

depth and amplitude measurements. Prior to collecting the data the user must manually decrease the gain. 

4 Position the antenna midpoint at the start of the marked profile line.  

• The antenna midpoint is denoted by vertical indented lines on the red outer case on either side 
of the Model 5100(B) antenna.  

5 Collect the profile. If the SIR system beeps, the antenna is being moved too fast, so the person 
moving the antenna should slow down.  

• If the SIR system beeps more than 2 or 3 times during data collection along a single profile 
line, reject this file and collect the profile again.  

6 After collecting the whole dataset, obtain a calibration core to measure the depth to the top of one 
of the rebar. The calculated GPR velocity resulting from this calibration is used for calculating 
the remaining rebar depths from the data. 
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• Locate a rebar along the profile line, preferably within 6 feet (2 meters) from the starting 
point of the profile line. (Suggestion: Use the deepest bar in this zone for calibration.) 

• After drilling a hole and measuring to the top of the rebar from the concrete surface, record 
the distance from the start of the profile line to the calibration hole.  

• More details on the calibration procedure are given in Appendix B. 

7 Data collection should now be complete. It is up to the operator to make sure that data are 
acceptable for processing using RADAN. The three important things to check before leaving the 
bridge are: 

1. The data files were properly stored. 

2. The direct wave did not drift outside the window on any data files. 

3. The gain during data collection was not too high.  

Data Transfer and Processing 
1 Transfer the data from the SIR system to the computer that will process the data using the 

Windows transfer utility, Data Transfer Util.  

2 After data transfer is complete, start RADAN on the computer. 

3 Select the source (i.e., input) and output directories and the vertical and horizontal units that will 
be used during data processing. (See Appendix C for details.)  

4 In RADAN, open the data file collected along the profile line where the calibration core was 
drilled (if a calibration core is to be used in the analysis, as recommended). A typical file will 
appear like the one shown in Figure 4 below. 

 
Figure 4: Typical raw data file (Display Color Table #6, Color Transform #3). 

Note: The data appearance is significantly affected by the display parameters used. Much of the data 
shown in this manual are displayed with Color Table #6 and Transform #3. 

5 Activate the Bridge QA process by clicking the  button. The Bridge QA dialog box shown in 
Figure 5 will appear. The user must make several decisions: 
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Figure 5: Bridge QA dialog box. 

Velocity Calculation: The first decision is how the radar wave velocity will be calculated. The velocity 
is a critical parameter because it directly influences the calculated rebar depths. 

The only recommended method is to use calibration hole data obtained from measuring the depth to one 
of the rebar that the antenna passed directly over during data collection.  

• To implement calibration hole data, select the Use Calibration Hole Data option, then enter 
the calibration hole location relative to the start of the profile line and the measured rebar 
depth.  

• If the decision was made not to use calibration hole data, then the user should select Specify 
Concrete Velocity (if it is not already selected) and then enter the estimated or previously 
known concrete velocity.  

• The default velocity is 3.74 inches/nanosecond (9.5 cm/ns). 

Processing Options: The most common use for the Bridge QA module has been on newly constructed 
concrete bridge decks containing rebar between 1-4 inches (2.5-10 cm) in depth and at a spacing of 6 
inches (15 cm) between rebar.  

• The data processing algorithm uses these values to locate rebar unless the user changes these 
settings.  

• When the user clicks the Processing Options button, a dialog box opens that allows the user 
to modify the rebar location and spacing parameters.  

• The other parameter in the Processing Options dialog box is the Antenna ID option, which 
only applies to users with more than one Model 5100.  

• Each Model 5100 used for the bridge QA module should be calibrated at GSSI with the 
calibration settings entered into the dialog that opens when the user clicks Antenna 
Calibration Settings. See below for more details. Note: This function is not typically used 
anymore and is only important if you are collecting with multiple antennas. 

Antenna Calibration Settings: Clicking the Antenna Calibration Settings button opens a dialog box 
that allows the user to enter various antenna calibration parameters. Note: This function is not typically 
used anymore. 

• These parameters are automatically saved so the user only needs to enter them once.  

• If the user has only 1 antenna, the calibration parameters should be entered on the line 
corresponding to Antenna ID A.  

• The only important calibration parameter for Bridge QA work is the Time Zero calibration #. 
If the time-zero calibration # for your antenna is not known, call GSSI to obtain it. 
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6 After viewing the options, click OK to start processing the data file.  

• Yellow dots appear on the computer screen showing the locations of the automatically picked 
rebar.  

• When the processing is completed, a dialog will appear with a prompt to save the output file. 

• By default, the file will be written to the output folder specified in Step 13 unless otherwise 
specified at this point.  

• An ASCII file with the same root name as the output file and the extension .reb will be 
written to the output folder along with the processed .dzt file. This ASCII file contains all of 
the rebar pick information and associated statistics (see ASCII Output File section for 
details). 

7 Close the raw data file. The processed file should be the only file left open.  

8 The automatic rebar-locating algorithm does not always correctly locate all of the rebar. You will 
need to edit the output of the auto pick process in order to delete incorrect locations and to add 
missed rebar picks. This is done in a part of RADAN called Interactive Interpretation. Start the 
Interactive Interpretation by clicking the  icon, with the processed file open. You can also go 
to View>Interactive. You will see that the correct pick file will be selected in the Get Pick File 
window. It will have the same root name as the processed data file, but it will have the extension 
.reb. 

9 A window similar in appearance to the one shown in Figure 6 will appear. The data are shown in 
the upper half of the window (referred to as the data pane) and the rebar locations and depths on 
the lower pane. 

• Maximize the window for easiest examination. 

• The size of either the data or depth pane can be increased, depending on whether the data or 
the output picks are being more closely examined. A pick simply refers to an automatically or 
interactively selected data location (position and depth), represented by a colored dot. 

• You can increase thescreen display gain on the data pane by right clicking on it and choosing 
display gain from the pop-up window. 

 
Figure 6: Example of processed data shown in Interactive Interpretation window. The top half showing the picks 

on top of the data is the data pane. The bottom half showing the pick depths is the depth pane. 

Data Pane 

Depth Pane 
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Figure 7 shows examples of incorrectly and correctly picked rebar reflections. The reflection from a rebar 
appears as an arch or hyperbola. The correct location for the rebar reflection is near the center of the white 
portion of the arch (for Color Table #6 and Color Transform #3). 

 

 
 
 
 
 
 
  (a) Incorrectly picked rebar  (b) Correctly picked rebar 

Figure 7: Example of incorrectly and correctly picked rebar reflections. 

10 Look for areas in the data where a rebar pick may be missing or misplaced. Missing and 
misplaced rebar picks can be edited in Interactive Interpretation by opening the Pick Options pop-
up dialog box.  

a) Open the dialog box by placing the mouse cursor anywhere within the data pane (the 
upper half of the Interactive Interpretation window) and clicking the right mouse 
button.  

b) When the right mouse button is pressed, the Main pop-up menu shown in Figure 8 
appears.  

 
Figure 8: Main pop-up menu accessed by clicking the right mouse button when the mouse is positioned 

over data within the upper half of the Interactive Interpretation window. 

c) Choose Pick Options. The Pick Options dialog box will appear (Figure 9).  

 
Figure 9: Pick Options dialog box. Use this dialog to select the picking tool to be used for  

adding and deleting rebar picks. 
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Adding and Deleting Single Picks 

1 To add or delete picks, change the picking tool from Disabled to Single Point as shown in  
Figure 10. 

 
Figure 10: Selecting the Single Point Picking tool. 

2 Position the mouse cursor where a pick is to be added or deleted.  

• To add a pick, click the left mouse button.  

• To delete a pick, click the right mouse button.  

• The left and right mouse buttons will be reserved for adding and deleting picks until the 
Picking tool is changed from Single Point to a different tool, is disabled, or if the Pick 
Options dialog box is closed by the user. 

Figure 11 shows the process of adding a pick. The user has positioned the mouse cursor over the area 
where a rebar pick is missing and only needs to click the left mouse button. After clicking the left mouse 
button, a search process is performed on all of the scans between the left and right inside edges of the 
mouse cursor to locate the scan corresponding the center of the rebar.  

 
Figure 11: Example of mouse cursor placement prior to adding a pick. 

If the search is successful, a yellow (or other desired color, see section on Other Options) will appear on 
the data as shown in Figure 12. If no pick is added after clicking the left mouse button, reposition the 
mouse cursor and click the left mouse button again.  
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Figure 12: Successfully added pick. 

Figure 13 shows a correctly positioned mouse cursor prior to deleting a pick. Even if a portion of the pick 
circle bisects the vertical midpoint of the cursor, the pick will be deleted from the database and from the 
screen once the right mouse button is clicked. 

 

Figure 13: Example of correct mouse cursor position prior to deleting a poor pick. 

Adding and Deleting Multiple Picks 

1 To add or delete multiple picks, change the picking tool to Select Block as shown in 
Figure 14.  

 
Figure 14: Activating the Select Block option as the current Picking tool. 

2 Position the mouse cursor where picks are to be added or deleted.  

3 Click the left mouse button to create a Select Block. The Select Block appears as a translucent 
square over the data with tiny square handles at each corner and on the centers of each side. 
These squares act as handles that can be used to resize the Select Block. Generally, the corner 
handles are more useful because they can resize both the height and length of the Select Block. 

4 Click one of these handles and hold the mouse button down as you drag the mouse cursor to 
resize the Select Block.  
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Release the mouse button when the Select Block reaches its desired size. Figure 15 shows a Select Block 
during resizing. The Select Block shown in Figure 15 has been extended so that it overlays a number of 
poor picks.  

 
Figure 15: Select block being resized. The user is dragging the bottom right corner of the Select Block with the 

mouse. This is evident by the “ ↔“ symbol. 

5 Picks are added and deleted using a pop-up menu that appears when the user clicks the right 
mouse button while the mouse cursor is placed inside the Select Block (Figure 16). 

 
Figure 16: Accessing the select block pick options by right clicking the mouse inside the select block. 

For the scenario shown in Figure 15 there are a number of poor picks. The best solution is to delete all of 
the picks, then add new picks.  

• In general, it is best to keep the Select Block vertical width to a minimum. The vertical 
dimension of the Select Block shown in Figure 16 is approximately correct. 

• Once all of the Select Block operations are completed, close the Pick Options dialog or select 
a different picking tool. 

6 After finishing adding and deleting picks, position the mouse in the Interactive Interpretation data 
window and click the right mouse button to access the Main menu. From the Main menu, select 
Save Changes > Current File as shown in Figure 17.  

 
Figure 17: Saving changes to the *.reb file prior to exiting RADAN. 
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7 Data processing is complete.  

• All of the processing results are stored in ASCII format in the *.reb file. The *.reb file will be 
located in the default output directory (unless you specify otherwise).  

• The .reb file can be opened and viewed in Notepad, or as an ASCII, comma-separated-value 
(.csv) file in a wide range of spreadsheet and word processing software programs. Data can 
also be plotted using appropriate plotting or mapping software. 

There are additional options and features associated with the Interactive Interpretation process that are 
described in detail in Chapter 5. 

Setup Requirements 
In order for the Bridge QA module to work properly, the data must have certain characteristics. These 
characteristics include the hardware setups on the SIR unit during data collection. These setups are listed 
below: 

Hardware Settings: SIR-20, and SIR-3000 

Scans/m (ft) 80 (24)**   

Vertical FIR Low Pass Filter  3000 MHz  

Vertical FIR High Pass Filter 250 MHz  

# of Gain Pts  1  

Bits Per Sample  16 

Samples/Scan  512** 

Range  6 

Gain  ŧ 

Position   ŧ 

** Denotes minimum requirement – can be set higher. 
ŧ Denotes manual adjustment required. 
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Data Collection Procedure Requirements 
The data collection procedure used to obtain high quality data depends on the application. 

The following conditions must be strictly followed during data collection for accurate concrete cover 
assessment. 

• The data must be obtained over a concrete bridge deck or similar type of concrete construction 
using a Model 5100(B) antenna. 

• Data must be collected perpendicular to the direction of the bars within the top layer (mat) of 
reinforcement. For example, if the transverse bars are on top, the data should be collected along 
profile lines directed parallel to the direction of traffic. If longitudinal bars are on top, profile 
lines should be collected perpendicular to the direction of traffic. 

• The rebar must be spaced at a minimum of 4” (10 cm). 

• The bottom of the antenna (or its enclosure) must be in contact with the bridge surface at all 
times. 

• The survey wheel must be in contact with the bridge surface at all times. 

• The portion of the bridge deck surface being surveyed must be cleared of pebbles and other 
construction debris, including small metal objects such as wire or nails. 

• The bridge deck surface must not contain puddled water but may be wet. 

Figure 18 shows the antenna setup used during data collection on a bridge deck. The Model 5100 antenna 
is placed in the protective bucket of the survey cart. Survey wheel control is provided by the distance 
encoder mounted on the cart. BridgeScan will also work with the 5100B antenna and survey wheel 
encoder adaptor cable. 

Note: This module will not process data properly without survey wheel scan control, nor can it 
currently be used to process data obtained with other GSSI antennas. 

 
Figure 18: Antenna setup used to obtain rebar data over a concrete bridge deck. 
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ASCII Output File 
The final product from the Bridge QA process is the ASCII database file written with the input file root 
name and the extension .reb. This file contains the location (X and Y coordinates of a 3D file)), depth (in 
user-defined units), arrival time, and amplitude of each rebar reflection detected in the GPR data. The 
ASCII file can be examined using all software packages that can read text files. 

Caution: A previously generated ASCII file associated with a data file is automatically overwritten 
when the REBAR process is rerun on the data file. To prevent this, rename the ASCII file to a different 
name prior to rerunning the REBAR process. 

The first 6 lines of the ASCII output file shown in Figure 19 contain statistical information calculated 
from the rebar depths. Each statistical category is discussed briefly below. 

Average Rebar Depth: Mean depth to the top of rebar in the concrete structure. 

Concrete Velocity: Propagation velocity of the radar waves in the concrete. This value is either 
specified by the user or calculated from the core information obtained from a rebar located in the profile. 
(See Appendix A for details regarding calibration cores.) 

Number of Rebar: Total number of rebar detected in the GPR data. 

Minimum Rebar Depth: Minimum rebar depth, in user-defined units, in the entire data file. 

Maximum Rebar Depth: Maximum rebar depth, in user-defined units, in the entire data file. 

Standard Deviation: Standard deviation of the rebar depths, in user-defined units. 

The X and Y coordinates, depths, reflection amplitudes, and reflection arrival times of each detected rebar 
are listed following the header information. The X-distance is relative to the start of the file, and the depth 
is in user-defined units, representing the calculated depth from the concrete surface to the top of the rebar. 

Note: The first line of the ASCII file contains a warning about modifying the file, which may prevent it 
from being used again in RADAN. To prevent modifying the ASCII file, make a copy of the file: 

1 Right-click the file name in Windows Explorer. 

2 Select Copy from the pop-up menu. 

3 Paste the new file into the same directory. 

4 A new file, named "copy of *.reb" will appear in the folder along with the original ASCII file. 
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WARNING: Modification of this ASCII file outside of RADAN may cause unpredictable 
behavior when this file is reloaded into RADAN. 
 

Data Filename =  FILE290.DZT     
Calibration Core Depth =  2.600000 in    

Calibration Core Location =  4.040000 ft    

Average rebar depth =  2.589036 in    

Concrete Velocity =  4.327070 in/ns    

Number of rebar =  232     
Minimum rebar depth =  1.676456 in at 82.069160 ft   
Maximum rebar depth =  3.037834 in at 57.110989 ft   
Standard Deviation =  0.242212 in    

File X(ft) Y(ft) Depth(in) Time(ns) Amplitude  

FILE290 0.14 0 2.71 1.359 6577   

FILE290 0.61 0 2.655 1.336 8027   

FILE290 1.37 0 2.628 1.324 9563   

FILE290 2.01 0 2.6 1.313 9241   

FILE290 2.73 0 2.655 1.336 7450   

FILE290 3.35 0 2.628 1.324 7865   

FILE290 4.04 0 2.6 1.313 9161   

FILE290 4.68 0 2.628 1.324 9680   

FILE290 5.33 0 2.628 1.324 8694   

FILE290 5.88 0 2.6 1.313 10939   

FILE290 6.5 0 2.6 1.313 8136   

FILE290 7.47 0 2.6 1.313 8927   

FILE290 9.15 0 2.655 1.336 7755   

FILE290 10.09 0 2.71 1.359 7072   

FILE290 10.49 0 2.655 1.336 8460   

FILE290 11.43 0 2.683 1.348 7210   

FILE290 11.8 0 2.6 1.313 8544   

FILE290 12.55 0 2.6 1.313 8154   

FILE290 13.39 0 2.628 1.324 8707   

Figure 19: Typical ASCII output file from the Bridge QA process.  
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Chapter 3: Concrete Condition Assessment of 
Bridge Decks Using the Model 5100(B) 

Antenna 

Overview 
This technique allows you to locate areas of probable concrete deterioration in a bare concrete or asphalt 
overlaid concrete deck. This is done by graphing the relative reflection amplitudes across the survey area 
and assigning threshold values to the amplitude range. The basic premise is that areas of deterioration will 
attenuate (weaken) the radar signal. It is important to note that this technique does not indicate the type or 
cause of the deterioration, merely its presence. 

This application does have some limitations. Because the technique shows relative change across the 
single deck, data from different decks cannot be compared. Each deck must be understood in a vacuum. 
Furthermore since the application depends on mapping differences, this technique is not appropriate for a 
deck with no deterioration or a deck with near total deterioration. 

Any meaningful deterioration map is created by a fusion of the radar data with a comprehensive visual 
inspection of the deck. The analyst should take careful notes of the location of any surface defect on the 
top or the bottom of the deck. This allows the analyst to identify areas of extreme deterioration and thus 
“calibrate” the map output. The presence of any patch or crack should be noted on the top surface and any 
spalling, staining, or efflorescence should be noted on the bottom. If possible, obtain any maintenance 
records. 

Data Collection 
1 Turn on the SIR unit and recall the saved radar setting for concrete condition assessment of 

bridge decks.  

• If no previously saved setting is available, use the setup parameters described at the end of 
this chapter. 

2 Let the SIR unit warm up for a recommended time of 5-10 minutes with the scan showing on 
the screen.  

3 During the warm-up period, it is recommended that the number and spacing of the profile lines be 
established.  

• A 2-foot (0.6 m) spacing or less between adjacent profile lines (Y-spacing) is recommended. 
Mark the profile lines over which data will be collected.  

• It is good practice to record the distance of the first and last profile lines from the bridge curb 
relative to permanent reference points.  

• It is also important to map asphalt patches and cracks.  
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Note: It is also essential that the profile line direction be perpendicular to the direction of the 
top layer of rebars. This means if the transverse bars are tied on top in the top rebar mat, the data 
should be collected along the lane in the direction of traffic. For the case when longitudinal rebars 
are on top, data should be collected across the lanes. 

4 Next, after the 5-10 minute warm-up period and just prior to collecting data, check the position 
and gain of the scan in the display window and adjust if necessary. The scan position and gain 
should look similar to that shown in Figure 20. Note: Your SIR System may display the scan 
trace in a vertical orientation. The direct wave will then be near the top. 

Caution: Remember, if a portion of the direct wave is missing during data collection or if the gain is 
too high, the data won’t be processed correctly in RADAN. Figures 21 and 22 illustrate a badly 
positioned scan and a clipped scan, respectively. 

 
Figure 20: Typical waveform shape with antenna positioned over rebar. The signal is set up so that the direct 

wave and the peak amplitudes are well within the boundaries of the sampling window.  

 

Figure 21: Badly positioned waveform. The direct wave is not located in the window. Using the signal positioned 
as shown in this figure would cause the program to give erroneous results. Prior to collecting data the user must 

manually adjust the signal position until the direct coupling is located entirely in the window (see Figure 20).  

 
Figure 22: Example of clipped waveform. Clipping must be prevented for accurate rebar depth and amplitude 

measurements. Prior to collecting the data the user must manually decrease the gain. 



Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 19 

5 Position the antenna so it is at the correct Y-distance from the bridge curb or lane stripe.  

• Also make sure the antenna is positioned directly on top of the start of the bridge or is 
positioned some distance before the start of the bridge. Normally you will be able to locate 
the start of the bridge from examination of the data during post processing in cases where you 
begin collecting data prior to the start of the bridge. Typically, a strong reflection from the 
expansion joint (metal) is seen at one or both ends of the deck. 

• It is not crucial to start and end each profile at the same point as long as each profile begins 
before the bridge joint and ends after the bridge joint. 

6 Collect the profiles. If the SIR system beeps, the antenna is being moved too fast, so the person or 
vehicle dragging the antenna must slow down. If the SIR system beeps more than 2 or 3 times 
during data collection along a single profile line, reject this file and collect the profile again..  

• Cracks and patches can be mapped along with the data by using a marker switch on either the 
SIR system or the survey wheel/handle assembly.  

• Collect and store a single data file per profile line.  

• Separate or alternating profile lines can be collected in opposing directions (e.g., one line 
starting at the beginning of the bridge and traversing to the end of the bridge; with the next 
line starting at the end of the bridge and traveling to the beginning of the bridge.  

• There is an option in RADAN to reverse the direction of data in the files during processing of 
single channel data files. The reverse file option is disabled for multiple channel data files. 
Therefore, it is recommended that if multiple channel Model 5100 data files are collected that 
they all be collected in the same direction.  

Data Transfer and Processing 
1 Transfer the data from the SIR unit to the computer that will process the data following the steps 

outlined in your SIR System manual. After data transfer is complete, start RADAN on the 
computer.  

2 Select the source (i.e., input) and output directories and the vertical and horizontal units that will 
be used during data processing (see Appendix C for details).  

3 In RADAN, open a data file collected along a profile line. A typical file will appear like the one 
shown in Figure 23. However, the rebar spacing, hyperbola shapes, and asphalt thickness may 
vary widely from one bridge deck to another.  

• The data appearance is significantly affected by the display parameters used. Most of the data 
shown in this manual are displayed with color table #6 and color transform #3. 
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Figure 23: Typical single-channel, raw data file of an asphalt-overlaid bridge deck  

(Display Color Table #6, Color Transform #3). 

4 The first major objective is to create a 3-D data file from the individual files. Before this is done, 
a macro must be created. A macro is a set of processing steps, or instructions, attached to 
individual data files in a project. The macro will be different depending on whether single- or 
multiple-channel data files were collected. 

Macro Creation for Single Channel Data Files 
For single channel files this macro will contain a transparent process that will not effect the data, but its 
presence is necessary for running the project. 

1 With the data file open, click the Create Macro button . 

2 A dialog box appears that prompts the user to enter a name for the macro. Supply a name and 
click OK.  

3 The new macro is ready to add processing steps. Click the Arithmetic Functions Processing 
button .  

4 A dialog box will appear; don’t make any changes to the items in the dialog. 

5 Click OK. 

6 Close the macro by clicking the Close Macro button . 

7 A dummy macro has been created. In effect, you will be multiplying each data sample in the 
profile (data file) by one; so this macro will not influence the data, but is necessary to run a 
project. 
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Macro Creation for Multiple Channel Data Files 
The macro created for multiple channel data files will correct for differences in the amplitude of data 
collected by different Model 5100 antennas. The relative differences in amplitude between the antennas 
should be known beforehand. There are a number of ways to obtain relative amplitudes.  

• The user could place the antennas at a known height above a metal plate and compare the 
reflection amplitudes, or 

• Collect data on a concrete slab along a repeatable profile line containing a number of rebars 
and measure the average differences in amplitude of the rebar reflections between the 
antennas. This is the recommended approach.  

For all calibration measurements it is essential that the user use straight gain (i.e., one gain point or two 
gain points with the same gain for each point). The objective of the calibration measurements is obtaining 
the ratio of reflection amplitudes between the antennas. The reflection amplitudes between Model 5100 
antennas should differ by less than 10%. Once this amplitude ratio is obtained, the user needs to create a 
macro that allows this number to be put to use on the collected data. Note: This technique is not used for 
data collected with one antenna. 

1 With the data file open, click the Create Macro button . 

2 A dialog box appears that prompts the user to enter a name for the macro. Supply a name and 
click OK.  

3 The new macro is ready for adding processing steps. Click the Deterioration Mapping button  
to open the dialog box shown in Figure 24.  

 
Figure 24: Dialog box that appears after clicking the Deterioration Mapping button with  

a multi-channel file open. 

4 Click the Antenna Calibration Settings button to open the Antenna Calibration Settings dialog 
box shown in Figure 25.  
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Figure 25: Dialog used to enter pre-generated calibration amplitude ratios for different antennas.  

5 Enter the amplitude ratio values for the different antennas in the A2 column and remember which 
antenna belongs to which antenna ID. (The other calibration parameters, Time Zero, DCC, and 
A1, aren’t currently used in the bridge condition mapping portion of the Bridge Assessment 
module.) If using only one antenna, skip this step. 

For example:  

Two Model 5100 antennas were used to collect data and antenna A (assuming it is to be 
considered a reference antenna) had an average rebar reflection amplitude that was 1.03 times the 
reflection amplitude of antenna B –  

• The user would enter 1.03 into the A2 column associated with Antenna ID B and leave the 
value 1 in the A2 column associated with Antenna ID A. The A2 parameter is multiplied with 
the data from the associated antenna to correct it relative to the data from the reference 
antenna. The same principle would apply to antenna combinations greater than two. 

6 Close the macro by clicking the Close Macro button .A macro is now created. This macro will 
be used while the project is running. 

7 Close the data file and any other open files.  
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Creating the 3D File 

1 Choose File > New. The Create New Project dialog box will appear (Figure 26). Enter a project 
filename and select RADBridge Project (as shown in the figure). Click Save. 

 
Figure 26: Create New Project dialog. Enter a filename and click RADBridge Project as shown. 

2 The Project Information dialog box will appear (Figure 27). 

• Check to make sure the Output Path listed in the dialog is the desired path. 

• If it isn’t, click the Output Path button to select a different Output path. The Output Path is 
the directory that stores the intermediate processed data files. 

 
Figure 27: Project information dialog box.  

All of the other information entered in the Project Information dialog is for the user’s benefit only. It does 
not influence how the project runs. When you have finished entering information in the Project 
Information dialog box, click OK. 
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3 Enter the data files in the Edit Project File List dialog box (Figure 28).  

• Data files can be added by clicking on the data file and clicking the Add button as shown in 
Figure 28, or by double clicking on the file.  

• For bridge deck evaluations, each file will have a different Y coordinate associated with its 
position relative to the right lane stripe, bridge-curb or other fixed reference. In all RADAN 
data files (profiles), distance increases in the positive X-direction.  

• Files can be removed from the project by clicking on the added file and clicking the Remove 
button.  

• The example in Figure 28 shows the naming and numbering sequence of the files, relative to 
Y-distance from the right lane-stripe and to the direction of the scan relative to traffic flow in 
the bridge.  

• In this case, 12 eastbound lane profiles were collected spaced sequentially from 1 to 23 feet 
left of the right lane-stripe. Those with an “*r.dzt” indicate that data were collected in the 
direction opposing traffic flow on the bridge. (It has been found that renaming data files so 
that their relative position and direction are indicated in the filename helps to prevent 
confusion and errors during post-processing.) 

• When all of the files have been added in order of increasing Y-coordinate, click Done. 

 
Figure 28: Adding files to a project. 

4 The next step is to attach the macro to the files in the project. The Edit Macro List dialog box will 
appear.  

a) Click on the macro previously created. Figure 29 shows an example with the macro 
called Addsub.cmf. Note that its name now appears in the Filename dialog box. 
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Figure 29: The user has just clicked on the macro “Addsub.cmf” 

b) Next, click on a data file to highlight it and click the Attach Macro button as shown in 
Figure 30. You will see the name of your macro file immediately to the right of the 
file to which it will be attached. 

 
Figure 30: Attaching the macro Addsub.cmf to a data file. 

c) Repeat the process for all of the data files listed in the project. 
• To select all the data files in the project, click the first file in the list. Hold down the shift 

key and click the last file in the list. 
• To select multiple files, hold down the Control (CTRL) key and click each desired file 

name. 

5 Click Done to advance to the next dialog box. The next dialog box is 3D File Parameters. The  
3-D output filename, 3-D grid dimensions, and the X and Y coordinates of the files are entered 
using this multi-page dialog box.  
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a) Click the 3D Output Filename button and enter the desired name of the output  
3-D file (Figure 31).  

 
Figure 31: Selecting the 3-D output filename using the button. 

b) In the Grid Parameters tab, enter the starting and ending X- and Y-coordinates of the 
grid.  
• The X-direction is profile direction and the Y-direction is perpendicular to the profile 

line direction.  
• For example, if the bridge is constructed with transverse rebars on top of longitudinal 

rebars, and data were obtained over a 100 ft length in 2 lanes that were 12 feet wide, the 
grid coordinates in units of ft (meters) would be: 

X Min = 0.0 (0.0) 

X Max = 100.0 (30.48) 

Y Min = 0.0 (0.0) 

Y Max = 24. (7.315) 

c) If the profile lines were uniformly spaced, keep the Y Profile Lines Evenly-Spaced 
checkbox checked as shown in Figure 31. Otherwise, deselect it so you can enter 
actual Y-coordinates for each data profile. 

d) Don’t change the scan/unit value. This number is for display purposes only and is 
taken from the header of the first file entered in the project.  

e) Click on the Files 1-8 tab (Figure 31) then enter the starting X-coordinate and the 
Y-coordinate of the profile lines. Generally, the Starting X coordinate corresponds to 
the start of the bridge.  
• To locate the start of the bridge on any given profile, click the button Click, in the 

column Get Xo. 
• The associated file will open on the screen. Move the mouse cursor to the start of the 

bridge and click the left mouse button at the interpreted start of the bridge as shown in 
Figure 32. The new X-coordinate of the start of the data file will automatically be 
displayed in the Xo box associated with the file. The number entered in the box will 
generally be a negative number, or zero if the start of the file is at the start of the deck. 
Xo refers to the start of the deck. 
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Figure 32: Selecting the X Start (Xo) value for the bridge by clicking the left mouse button at the  

bridge joint/ bridge deck junction. 

Note: The bridge deck/bridge joint junction at the end of the data file is entered when selecting Xo for 
data profiles collected in the reverse direction. The Rev box must also be selected in these cases.  

f) Continue selecting the Xo for all of the files, then manually enter the Y coordinates if 
the profiles were not evenly spaced. In the example presented in Figure 32, the profile 
lines were obtained at 2-foot (0.6 m) intervals starting 1 ft (0.3 m) from the right lane 
stripe. 

g) After all of the X- and Y-coordinates of the files have been selected for all of the File 
tabs, (more file tabs appear when there are more than 16 files) click OK. The project 
is now ready to be run. 

6 To run an open project, choose Project>Run. 

The project may take some time to process the data files, depending on the size of the files, the RAM 
memory in the computer, and the speed of the processor(s) in the computer. Please be patient, and  
DO NOT DISTURB the computer in any way until the project has finished running. 

Running the Deterioration Mapping Process 
Next, the output 3-D file must be processed through the Deterioration Mapping process. Click the 
Deterioration Mapping button  to open the dialog box.  

1 Click the Processing Options button.  

2 There are two parameters that may be adjusted in the Processing Options dialog box (Figure 33) - 
the Time-Zero Amplitude Threshold and the Migration Velocity.  

• Time-Zero Amplitude Threshold is important for locating the time-zero in the scan. The 
program will use the peak immediately following the first portion of the scan that exceeds the 
time-zero amplitude threshold.  
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• The value of 3000 generally works well. If the peak amplitude of the direct coupling is less 
than 3000, you will need to lower the time-zero amplitude threshold. Figure 34 shows a scan 
in O-Scope display mode with the direct-coupling peak labeled. In this case, the direct-
coupling peak has a value of 20000 (20K = 20000), well above the 3000 threshold.  

 
Figure 33: Processing Options dialog box. 

 
Figure 34: O-scope display of scan. 

Migration Velocity, the second important parameter, is the radar wave propagation velocity used in the 
migration process. Migration is basically an imaging process that collapses the arches (or hyperbolas) 
associated with rebar reflections.  

For this process we need an estimate of how fast the radar wave propagates through the asphalt and 
concrete. The typical ranges of velocities are 4-6 in/ns (10-15 cm/ns). It is up to the user to choose the 
correct velocity.  

You may not pick the correct migration velocity the first time, so observe the processed data (after 
clicking OK to close the dialogs) and click the Stop  button to stop the process, and restart the process 
with a different migration velocity.  

Figure 35 shows data processed using 3 different migration velocities. The migration velocity of 4 in/ns 
(10 cm/ns) was too low. Note that the hyperbolas weren’t totally collapsed. The migration velocity of 6 
in/ns (15 cm/ns) was too high. The hyperbolas were reversed – they now look like the letter “V.” The best 
migration velocity for this dataset was 5 in/ns (12.5 cm/ns).  

Direct Coupling  

Amplitudes (20K = 20000)  
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Figure 35: Comparison of data processed with 3 different migration velocities: (a) raw data, (b) migration at  

4 in/ns (10 cm/ns), (c) migration at 5 in/ns (12.5 cm/ns), and (d) migration at 6 in/ns (15 cm/ns). 
The best migration velocity was 5 in/ns (12.5 cm/ns). 

3 You won’t normally have to change the Vertical Filter options in Figure 33. By keeping the 
option set at Automatic, Vertical Boxcar filters will be applied to the data only if no filters or 
improper filters were applied in the data file’s processing history.  

• For unusual cases, you can select Specified and apply your own Vertical filters. The specified 
frequencies correspond to the cutoff frequencies of the Boxcar filters. 

4 The Calibration Settings are not used in the Deterioration mapping process.  

a) Click OK to exit the Processing Options dialog box.  

b) Next, click OK in the Locate Rebars dialog box to start the deterioration mapping 
process. The data are processed in 1000 scan batches, so be patient.  

c) If the data are not being migrated properly (see Figure 35 for comparison), click the 
Stop  button and restart the process with a different migration velocity. Do this 
until the desired results are achieved.  

d) Once the entire process is completed, save the output file. An ASCII file with the 
same root name as the data file and the extension .det will be created in the same 
folder as the output file. 

5 The next step is to examine the performance of the automatic rebar picking process and edit poor 
picks. This will be done in the Interactive Interpretation module.  

a) With the output file open and active, click the Interactive Interpretation button .  

(a) Raw Data 

(b) Migration at 4 in/ns (10 cm/ns) 

(c) Migration at 5 in/ns (12.5 cm/ns) 

(d) Migration at 6 in/ns (15 cm/ns) 
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b) The Get Pick File dialog box will appear (Figure 36). You will need to select the 
ASCII file created in the deterioration mapping process.  

 
Figure 36: Get Pick File dialog box. For newly processed files, select the output ASCII file. 

c) Click the Pick File button to open up the dialog box that allows you select the ASCII 
file. It has the same root name as the data file and the extension .det.  
• For example, if the output file name is BRG EXAMPLE.DZT, the ASCII file name will 

be BRG EXAMPLE.DET.  
• You could also leave the Generate New Pick File box checked if you want to do all of 

the rebar picking manually, but this is not recommended. 

d) After clicking OK, a new window will appear containing the data in the top pane and 
a depth chart on the bottom pane. The rebar picks will be overlain on top of the data 
in the data pane and at the calculated depths in the depth pane (Figure 37).  

 
Figure 37: Rebar picks from deterioration mapping process shown in the Interactive Interpretation window. 

Good rebar picks and poor rebar picks are illustrated. Color Table 17 and a 
Display Gain of 8 were used for this figure.  

Figure 37 illustrates good rebar picks, whereby the yellow dot is placed in the middle of the white area of 
the rebar reflection. This is the objective. Figure 37 also contains some yellow dots where there are no 
rebar reflections. These need to be removed.  

Good Picks 
Poor Picks 
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All of the Interactive Interpretation options are selected from the Main pop-up menu that is accessed by 
right clicking the mouse anywhere inside the data pane, as shown in Figure 38.  

 
Figure 38: Main pop-up menu accessed by clicking the right mouse button inside the  

Interactive Interpretation data pane. 

From the Main pop-up menu, select Pick Options to open the Pick Options dialog box (Figure 39). The 
Pick options dialog box contains different pick editing tools.  

 
Figure 39: Pick Options dialog box. 

Adding and Deleting Single Picks 

1 To add or delete picks, change the picking tool from Disabled to Single Point as shown in  
Figure 40. 

 
Figure 40: Selecting the Single Point picking tool. 

2 Position the mouse cursor where a pick is to be added or deleted.  

• To add a pick, click the left mouse button.  

• To delete a pick, click the right mouse button.  

• The left and right mouse buttons will be reserved for adding and deleting picks until the 
Picking tool is changed from Single Point to a different tool or is disabled or if the Pick 
Options Dialog is closed by the user. 
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Figure 41 shows the process of adding a pick. The user has positioned the mouse cursor over the area 
where a rebar pick is missing and only needs to click the left mouse button. After clicking the left mouse 
button a search process is automatically performed on all of the scans between the left and right inside 
edges of the mouse cursor to locate the scan corresponding the center of the rebar.  

 
Figure 41: Example of mouse cursor placement prior to adding a pick. 

If the search is successful, a yellow (or other desired color, see section on Other Options) will appear on 
the data as shown in Figure 42. If no pick is added after clicking the left mouse button, reposition the 
mouse cursor and click the left mouse button again.  

 
Figure 42: Successfully added pick. 

Figure 43 shows a correctly positioned mouse cursor prior to deleting a pick. If a portion of the pick circle 
bisects the vertical midpoint of the cursor, then the pick will be deleted from the database and from the 
screen.  

 
Figure 43: Example of correct mouse cursor position prior to deleting a poor pick. 
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Adding and Deleting Multiple Picks 

1 To add or delete multiple picks, change the Picking tool to Select Block as shown in 
Figure 44. 

 
Figure 44: Selecting the Select Block option as the current Picking tool. 

2 Position the mouse cursor where picks are to be added or deleted.  

3 Click the left mouse button to create a Select Block. The Select Block appears as a translucent 
square over the data with tiny square handles at each corner and on each side.  

4 Click on one of these handles and hold the mouse button down as you move the mouse cursor to 
resize the Select Block. 

5 Release the mouse button when the Select Block reaches its desired size. Figure 45 shows a 
Select Block during resizing. The Select Block shown in Figure 45 has been extended so that it 
overlays a number of poor picks.  

 
Figure 45: Select Block being resized. The user is dragging the bottom right corner of the Select Block  

with the mouse. This is evident by the “↔↔“ symbol. 

6 Picks are added and deleted using a pop-up menu that appears when the user clicks the right 
mouse button while the mouse cursor is inside the Select Block (Figure 46). 

 
Figure 46: Accessing The Select Block pick options by right clicking inside the Select Block. 
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For the scenario shown in Figure 46, there are a number of poor picks. The best solution is to delete all of 
the picks, then add new picks.  

In general, it is best to keep the Select Block vertical width to a minimum. The vertical dimension of the 
Select Block shown in Figure 46 is approximately correct. 

7 Once all of the Select Block operations are completed, the user should close the Pick Options 
Dialog, or select a different Picking tool. 

Exporting Data 
After finishing adding and deleting picks, position the mouse in the Interactive Interpretation data 
window and click the right mouse button to access the Main pop-up menu.  

1 From the Main pop-up menu, select Save Changes > Current File as shown in Figure 47.  

 
Figure 47: Saving changes to the *.det file prior to exiting RADAN. 

2 After saving changes to the ASCII file, you can exit RADAN. Data processing is complete.  

• All of the processing results are stored in ASCII format in the *.det file. The *.det file will be 
located in the default output directory (unless otherwise specified).  

• The .det file can be opened and viewed in Notepad, or as an ASCII, comma-separated-value 
(.csv) file in a wide range of spreadsheet and word processing software programs.  

• This *.det file can be reloaded into RADAN at any time to make further modifications.  

There are additional options and features associated with the Interactive Interpretation process that are 
described in detail in Chapter 5. For example, if you need to correct the (X,Y) coordinates of the profile 
lines for bridge joint skew angle, please see Chapter 5 for details.  

ASCII Output File 
Figure 48 shows a typical ASCII output file from the concrete condition assessment portion of the Bridge 
Analysis module.  

Note: You should never try to modify this file outside of RADAN, then reopen the file in RADAN. 
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WARNING: Modification of this ASCII file outside of RADAN may cause unpredictable behavior when this file is reloaded into 
RADAN.      

Version =  5                    

Skew angle at start of bridge = 0.000000                

Amplitude Units =  Normalized Decibels                

Data Filename =  NLOWELL P.DZT                

File Ch# Scan# x(ft) y(ft) Target z(in) Amp Vel. Type v(in/ns) t(ns) Color Size 
Diam 
(in) 

Pick 
Crit. Group Hide Link 

Mat
erial Confid. 

NLOWELL P1 1 0 0 0 Rebar 6.954 -35.56 Specify 5.118 2.754 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 7 0.287 0 Rebar 6.954 -30.19 Specify 5.118 2.754 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 16 0.656 0 Rebar 6.701 -27.2 Specify 5.118 2.656 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 25 1.025 0 Rebar 6.701 -27.7 Specify 5.118 2.656 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 33 1.353 0 Rebar 6.65 -28.06 Specify 5.118 2.637 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 44 1.804 0 Rebar 6.346 -26.37 Specify 5.118 2.52 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 59 2.42 0 Rebar 6.244 -24.85 Specify 5.118 2.48 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 67 2.748 0 Rebar 5.939 -24.63 Specify 5.118 2.363 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 75 3.076 0 Rebar 6.193 -25.22 Specify 5.118 2.461 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 87 3.568 0 Rebar 6.142 -25.53 Specify 5.118 2.441 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 98 4.019 0 Rebar 6.193 -24.74 Specify 5.118 2.461 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 107 4.388 0 Rebar 6.041 -24.78 Specify 5.118 2.402 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 118 4.839 0 Rebar 5.99 -26.26 Specify 5.118 2.383 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 126 5.167 0 Rebar 5.99 -25.18 Specify 5.118 2.383 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 138 5.659 0 Rebar 5.837 -25.88 Specify 5.118 2.324 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 146 5.988 0 Rebar 5.786 -25.72 Specify 5.118 2.305 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 160 6.562 0 Rebar 5.582 -25.21 Specify 5.118 2.227 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 166 6.808 0 Rebar 5.48 -25.32 Specify 5.118 2.188 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 179 7.341 0 Rebar 5.531 -26.16 Specify 5.118 2.207 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 188 7.71 0 Rebar 5.582 -26.57 Specify 5.118 2.227 2 3 0 0 0 0 0 0 0 

NLOWELL P1 1 201 8.243 0 Rebar 5.48 -26.04 Specify 5.118 2.188 2 3 0 0 0 0 0 12 1 

NLOWELL P1 1 214 8.776 0 Rebar 5.633 -23.14 Specify 5.118 2.246 2 3 0 0 0 0 0 12 1 

NLOWELL P1 1 239 9.802 0 Rebar 5.99 -26.05 Specify 5.118 2.383 2 3 0 0 0 0 0 12 1 

NLOWELL P1 1 259 10.62 0 Rebar 5.684 -22.61 Specify 5.118 2.266 2 3 0 0 0 0 0 12 1 

NLOWELL P1 1 279 11.44 0 Rebar 5.531 -24.12 Specify 5.118 2.207 2 3 0 0 0 0 0 12 1 

NLOWELL P1 1 300 12.3 0 Rebar 5.48 -22.89 Specify 5.118 2.188 2 3 0 0 0 0 0 12 1 

 
Figure 48: Typical ASCII output from condition assessment using the Model 5100 antenna. 
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Data Collection Settings 
In order for the Bridge Condition Assessment post-processing software to work properly with Model 
5100 data, the data must have certain invariant characteristics. These characteristics include the hardware 
setups on the SIR unit during data collection. These setups are listed below: 

Hardware Settings: 

Scans/m 40 minimum, 80 recommended, 24/ft 

Vertical IIR Low Pass Filter  3000 MHz 

Vertical IIR High Pass Filter 250 MHz 

# of Gain Pts  1 

Bits Per Sample  16 
Samples/Scan  256 minimum, 512 recommended 

Range  8 

Gain  ** 

Position   ** 
 

** Denotes manual adjustment required. 
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Chapter 4: Concrete Condition Assessment on 
Bridge Decks Using Horn Antennas 

GSSI manufactures two different models of horn antenna, the Model 4108 and the Model 4105. For the 
4108, on asphalt overlaid bridge decks two antennas must be used and they must be mounted cross-
polarized as shown in Figure 49. This is because the lower frequency signals of the antennas must be 
compared and subtracted from each other in order to achieve the necessary resolution of the top layer of 
reinforcing. If the 4105 is used, then the survey can be performed with only one antenna on asphalt-
overlaid bridge decks. The 4105 should be mounted so that the long axis of the antenna is parallel to the 
long axis of the vehicle. 

Hardware Setup 
Mount the two pairs of Model 4108 horn antennas on the back of the data collection vehicle. Figure 49 
shows a typical setup for the Model 4108 antennas.  

4105 Note: If using the 4105, then only a single antenna is needed. The long axis of the 4105 should 
be parallel to the long axis of the vehicle. 

• The holes in the fiberglass rails are drilled so that the distance between the antenna centers is 
15.75” (40.0 cm).  

Note the other setup features: 

1. Antenna height approximately 19” (47.5 cm). 

2. Straps used to restrain antenna movement. 

3. Cables taped down. 

4. Channel 1 is the outer antenna and channel 2 is the inner antenna. 

Note: A single 4105 is channel 1. 

 
Figure 49: Setup for Model 4108 horn antennas for collecting bridge analysis data.  

The spacing between antenna centers is 15.75” (40 cm). 

Straps for Support 

Chan 1 

Chan 2 
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Data Collection 
In general: 

• Mark the profile lines over which data will be collected.  

• A 2-foot (0.6 m) spacing or less between adjacent profile lines (Y-spacing) is recommended. 

• The profile lines should be measured in a straight line generally parallel to travel direction along 
the lanes.  

• It is good practice to record the distance of the first and last profile lines from the bridge curb and 
the lane stripes or permanent reference to fixed structure positions.  

• It is also important to map asphalt patches and cracks. 

The following instructions assume that the SIR-20 control unit is being used for this application. 

1 Turn on the SIR-20 unit and double-click on the SIR-20 icon to enter the collection program. Set 
working directories and linear units under View>Customize. 

2 Create a new data collection project. Click on the File>New and enter a new file name. This will 
be the root name for all of the individual profiles. Click Save to move to the next screen. 

3 Review project information. This window will allow you to enter any notes that you want to 
preserve with the data collection project file. Also check to make sure that the output file path is 
correct. Then click Next. 

4 Check collection mode. Data must be collected with a properly calibrated survey wheel. Click on 
the Survey Wheel button and calibrate the survey wheel or DMI as described in the SIR-20 
manual. Click Next. 

5 Configuration. On this screen check: 

• Config Type: Bridge. 

• Config Name: H2.0GHz for the 4105 or H1.0GHz for the 4108(F). 

• Set Scans/ft to 6 or 20/m. 

• Click the Antenna Calibration File button. This will collect the first data file in continuous 
mode (no survey wheel). This is because your first file is the metal plate calibration (bumper 
jump) file. 

• Click Next. 

6 This screen allows you to create a new data collection macro or to use an existing one. The macro 
is nothing more than a saved list of collection parameter. The name of the macro is derived from 
the project name. The default is to create a new macro with the factory saved parameters for the 
antenna you selected in Step 5. 

• Put the metal plate under the antenna and click Next to initialize the antenna. You will see 
a stopwatch count and the laptop will beep several times (if the sound is turned on). 

Move on to the next section. 
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Data Collection Settings Review 
In order for the Bridge Condition Assessment post-processing software to work properly with Model 
4105 and 4108 data, the data must have certain invariant characteristics. These characteristics include the 
hardware setups on the SIR unit during data collection. These setups are listed below: 

SIR-20 Hardware Settings 
 

 
** Denotes manual adjustment required. 

Configuring the Scan 

1 Signal Position.  

The position and gain of the waveform shown on the screen of the SIR system are critical parameters that 
must be correctly adjusted in order for the data to be post-processed correctly.  

The horn antennas are typically mounted approximately 19” (47.5 cm) above the pavement surface, high 
enough to see the direct coupling and surface reflection separately.  
Figure 50 shows incorrectly positioned signals for the Model 4105 horn antenna. The same features apply 
for a single channel 4108 survey. The key point is to make sure that you have both the ground surface 
reflection and the direct wave (internal transmit-receive reflection) visible in the window. You can test 
them by pushing the antenna up and down. The ground surface reflection will move up and down, but the 
direct wave will stay horizontal. 

Setting Model 4108 Model 4105 

Ticks/m Depends on the encoder 
used for the survey 

Depends on the encoder used 
for the survey 

Scans/m 20  6/ft 20  6/ft 

Vertical Boxcar Low Pass Filter  3000 MHz  5000 MHz  

Vertical Boxcar High Pass Filter 250 MHz  250 MHz  

# of Gain Pts  1 1 

Bits Per Sample  16 16 

Samples/Scan  256 minimum 512 minimum 

Scans/Sec Maximum permitted by the 
SIR unit 

Maximum permitted by the 
SIR unit 

Range  12 12 

Gain  Auto, 1 point Auto, 1 point 

Position   ** ** 
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Figure 50: Incorrect Position, Too Little and Too Much of the Scan Trace 

 
Figure 51: Correctly positioned 4105 wave 
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2 Gain. 

The second very important parameter is the Gain adjustment. Single point gain is used for this 
application. (Number of Gain points = 1) 

The Gain must be set so that no part of the signal clips (i.e., flattens at the edges of the window). Your 
SIR System is designed to automatically set the gain within acceptable parameters. It does this during the 
antenna initialization period. In order to make sure that the gains are correct, you need to make sure that 
the antenna is positioned over representative conditions before initializing the antenna. That means that if 
you are collecting the first file as a metal plate calibration file, you must put the plate under the antenna 
before you initialize and remove it before you reinitialize for the next file. 

Move on to the next section. 

Collecting the First File as a Metal Plate Calibration File 
Now, it is time to collect a “bumper jump” calibration file. The metal plate should be under the antenna, 
you should see data scrolling across the screen, and the trace on the right side of the screen should look 
like Figure 51. 

1 Click the green arrow (Run) to begin collecting the file. The SIR-20 will run in continuous mode 
(no Survey Wheel). 

2 Jump up and down on the bumper. The ground reflection will turn into a wavy line. Keep 
jumping until the whole screen width is filled up with data. 

3 Click the red button with the white dot in it to save the data. 

4 Remove the metal plate from underneath the antenna (IMPORTANT!) 

Move on to the next section. 

Collecting the Data 

1 Click the green square (Run Project) and wait for the antenna to initialize. 

2 Start before the bridge so that you will have the reflection from the bridge joint in the data. 

3 Click the green arrow (Run) and wait for the screen to maximize. 

4 Drive across the bridge. If the SIR system beeps, the antenna is being moved too fast, and the 
person driving the vehicle must slow down. If the SIR system beeps more than 2 or 3 times, data 
collection along the profile line should be repeated. When you have crossed off of the bridge, 
click the red button with the white dot to stop and save data collection. 

• Move on to the next profile and follow steps 1-4 until you are done. It is OK to collect data in 
a zig-zag fashion with profiles running in alternate directions. Make sure to specify in your 
notes which files are in which direction.  
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Data Processing 
1 Transfer the data from the SIR unit to the computer that will process the data. You can also use 

the collection laptop on the SIR-20. Close the SIR-20 program and open RADAN.  

2 Go to View>Customize and select the source (i.e., input) and output directories and the vertical 
and horizontal linear units that will be used during data processing (see Appendix C for details). 

Generate Metal Plate Calibration File 

1 In RADAN, open the calibration file collected over the metal plates. A typical file will appear 
like the one shown in Figure 52.  

 
Figure 52: Typical raw metal plate calibration file (Color Table #17, Display Gain = 8) 

2 The first major objective is to process the metal plate calibration file. Click the Generate Horn 
Calibration File button  and adjust the parameters in the dialog box so that they match the 
parameters shown in Figure 53.  

 
Figure 53: Generate Calibration File dialog just prior to clicking OK. 
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Specifically, you will change the Antenna Config to RADBRIDGE Project and the antenna types to 
match the antenna you used. Click OK to begin processing. The output calibration file will have the 
extension .czt and will have an appearance similar to the one shown in Figure 54. 

 
Figure 54: Typical processed horn antenna metal plate calibration file 

Create the Reflection Picking Macro 
Now, we must create a macro that will use the processed metal plate calibration file. 

1 Close all open data files.  

2 Open a data file collected over the bridge deck (any data file will do). With the data file open, 
click the Create Macro button . A dialog will appear that prompts you to enter a name for the 
macro. Supply a name and click OK. The new macro is ready for adding processing steps.  

3 Click on the Horn Reflection Picking button . The Reflections Picking – Processing Options 
dialog box shown in Figure 55 will appear.  

 
Figure 55: Reflection Picking dialog box. 
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4 Make sure that the correct metal plate calibration file is specified. In not, Click the Calib File 
button and select the processed calibration file. The file you select will have a .czt extension.   

4105 Note: If you are using  single polarization 4108 or 4105, then you must set this 
separation value to 0. Click Finish after changing the value. 

5 Close the macro by clicking the Close Macro button . 

6 A macro is now created. This macro is necessary for running a project. Close all open data files 
and move on to the next step. 

Creating a Process Project 
The next step involves creating a RADAN Project.  

1 Choose File > New. A New Project window will come up. Type in a name and check the box for 
RADBridge project. Click Save. The Project Information dialog box will appear. Check to make 
sure the Output Path listed in the dialog is the desired path. If it isn’t, click the Output Path button 
to select a different Output path. The rest of the screen is for optional notes. Click OK. 

2 Enter the data files in the Edit Project File List dialog box (Figure 56). Data files are added by 
double-clicking on them in order. For bridge deck evaluations, each file will have a different  
Y-coordinate associated with its position relative to the right lane stripe or bridge-curb. When all 
of the files are added in order, click Done. 

3 Attach Macro. Click on a data file and click the Attach Macro button as shown in Figure 56. The 
same macro must be attached to all of the files. Click done. 

 
Figure 56: Attaching the macro Brg.cmf to a data file. 

4 Enter 3D file parameters. The 3-D filename, 3-D grid dimensions, and the X- and  
Y-coordinates of the files are entered using this multi-tab dialog box.  

a) Click the 3D Output Filename button and enter the name that you want to call the 
resulting 3D file. 
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b) Change the Antenna Config to Single Pol for the 4105 Horn or the 5100 ground 
coupled antenna (or for single polarization 4108 antennas used on concrete surface 
bridge decks). If you are using the 4108 antennas in the dual polarization 
configuration, then change to Dual Pol.  

 
Figure 57: Entering in 3D File Parameters 

c) Specify the grid outline.  
• XMin should be the x-value relative to the start of the bridge deck. Generally, except for 

exceptionally long bridges (where you may want to divide up and process the bridge data 
in segments), you will want to specify “0” for XMin.  

• The XMax parameter will correspond to the length of the bridge, except for 
exceptionally long bridges (where you may want to divide up and process the bridge data 
in segments.  

• The YMin value corresponds to the Y-coordinate of the first profile line and the YMax 
value corresponds to the Y-coordinate of the last profile line.  

For example, data collected in the project shown here were obtained over a 125-foot 
long bridge. The first profile line was obtained 4 feet from the right lane stripe and the 
last profile line was collected 28 feet from the right lane stripe. Therefore, the 
following coordinates were entered in the dialog shown in Figure 57: 

X Min = 0.0 ft (0.0 m) 

X Max = 125 ft  

Y Min = 4.0 ft  

Y Max = 28 ft 

d) If the profile lines were collected at evenly spaced Y-increments, keep the Profile 
Y-Coords Evenly Spaced box checked. Otherwise, deselect it. 

e) Don’t change the scans/meter indicated in the Grid Parameters dialog tab. This 
number is for display purposes only and is taken from the header of the first file 
entered in the project.  

f) In the Files 1-8 tab, enter the Starting X-coordinate (Xo) and the Y-coordinate of the 
profile lines. Generally, the Starting X coordinate corresponds to the start of the 
bridge.  
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g) To locate the start of the bridge, press the button Click. 

h) The associated file will open on the screen. Move the mouse cursor to the start of the 
bridge and click the left mouse button at the interpreted start of the bridge as shown in 
Figure 58. 
• The corresponding X-coordinate of the start of the bridge will automatically be entered 

in the Xo box associated with the file. 

 
Figure 58: Selecting the Xo value for the bridge by clicking the left mouse button at the location of the  

bridge joint/ bridge deck junction. 

Note: The bridge deck/bridge joint junction at the end of the data file is entered when selecting the Xo 
for data profiles collected in the reverse direction. The Rev box must also be selected in these cases.  

After all of the Xo and Y-coordinates of the files have been selected for all of the File tabs, (when there 
are more than 8 files) click OK. Everything on the screen will disappear. The project is now ready to be 
run. 

5 To run an open project, choose Project > Run. 

Run Horn Antenna Process 
Next, the output 3-D file must be processed through the Horn Antenna Bridge Analysis process.  

1 Click the Horn Antenna Bridge Analysis process button  to open the dialog box  
(Figure 59). 

 
Figure 59: Horn Antenna Bridge Deck Analysis Tool dialog box. 
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2 Select the Bridge Surface – Asphalt or Concrete.  

3 Specify the Rebar Configuration.  

• If the transverse rebar are located on top of the longitudinal rebar, select Transverse on top. If 
you are using a pair of 4108’s in dual polarization and the top rebar is longitudinal AND 
closer together than 8 inches, you can select Longitudinal rebar configuration.  

4 Click OK to start the data processing. The software will prepare a .lay file with preset target 
classes that you will work with in Interactive Interpretation.  

Note: The Horn Antenna Bridge Analysis Tool will not track the rebar layer for non-dual 
polarization projects with asphalt overlays. The reason for this is that it is extremely difficult to 
do with a high degree of success. This means that you will have to do your own layer picking 
using interactive interpretation. 

5 After the processing is complete, save the output file. An ASCII file with the same root name as 
the output file and the extension .lay is saved in the same folder as the output file. This ASCII file 
contains all of the rebar reflection pick information.  

Make Picks in Interactive Interpretation 
The next step is to examine the performance of the automatic rebar picking process and edit poor picks. 
This will be done in the Interactive Interpretation module.  

1 With the output file open and active, click the Interactive Interpretation button .  

2 The Get Pick File dialog box will appear (Figure 60). The name of the ASCII file created by the 
previous process will be displayed in the Pick File window.  

 
Figure 60: Get Pick File dialog.  

3 After clicking OK, a new window will appear containing the data in the top pane and a depth 
chart on the bottom pane. 

4 Use EZ Tracker to make picks for the asphalt bottom (if asphalt overlay), rebar, and bridge 
bottom (if seen). 
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Figure 61: Make Picks with EZ Tracker. 

EZ Tracker: EZ Tracker can be accessed by right clicking on the data pane and then clicking on Pick 
Options.  

• Set the Picking Tool to EZ Tracker and it will open the EZ Tracker control window.  

• Select the desired target in the current focus and click Start. Left click on the target and EZ 
Tracker will draw dots on the target to follow it through the data.  

• If it gets off track, right click to undo the previous short segment.  

• If you come to a gap, click Stop and then Start again on the other side of the gap. 

• Save every once in a while to save your picks. 

In general, it is not necessary to pick the asphalt bottom if you are doing concrete deterioration mapping. 
However, picking the asphalt bottom does provide you with extra useful information such as asphalt 
thickness. Regardless of whether you pick the asphalt bottom or not, it is still essential to note the location 
of any patches or cracking in the asphalt. This information is used for the development of the 
deterioration map. 

5 Once you are finished making picks, click save on EZ Tracker one more time to make sure that 
your data is saved. Close EZ Tracker. 

6 Enter Skew Angle. The last step is to enter the bridge joint skew angle. The is typically at a non-
normal angle to the bridge and is easy to measure from the bridge plans. Right click on the data 
pane and go to Global Options. Type in the skew angle in degrees counter-clockwise and close 
the Global Options window. 

7 Right click on the data pane and do a final save of the data by selecting Save Changes>Current 
Filename. 

8 You can now close RADAN. 

You have created a spreadsheet of information for each location that can be opening in Microsoft Excel 
and graphed in any graphing program that accepts ASCII .CSV data (very common). 
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Viewing the Data in Microsoft Excel 

1 Open Microsoft Excel and select File>Open.  

2 In the “Files of Type” dialogue, select All Files. The pick file will have the root filename of your 
data file with the extension “.lay.” 

3 Select that one and an import window will pop up. Select “Delimited” on Step 1 and then click 
Next to move to Step 2. Select “Comma” and then click Finish. You will see a spreadsheet 
similar to Figure 62. 

 

Figure 62: Excel Output. 
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Understanding the Output File 
 

 
Figure 63: Data Output. 

Figure 63 shows the Excel worksheet output from the picking process. The first 12 rows are file header 
information that shows some of the background information about the data set. In  
Figure 63, the data begins with the column headers at row 13. Each row is a pick location. EZ Tracker 
assigns three layers by default. If there is a pick for a scan location on one layer and not another, then that 
layer will show a zero for much of the other information.  

Each pick will have the following information: 

X: This is the pick’s location along the survey profile line. This value will be in the horizontal units which 
were selected under View>Customize. 

Y: This is the pick’s location along the Y axis of the survey area. This will typically be the same value for 
all picks from a given survey profile. This value will be in the horizontal units whichwere selected under 
View>Customize. 

Layer 1/2/3: This column shows the pick ID. This will be Asphalt for Layer 1, Rebar for Layer 2, and 
Bridge Bottom for Layer 3. If there is no pick for that layer at the given location, then it will display 
“None.” 

Z: This is the pick’s depth from the surface. This value will be in whichever vertical units were selected 
under View>Customize. This depth is cumulative. This means that if you would like to know the amount 
of concrete cover over the rebar in an asphalt overlay concrete deck, then you must subtract the asphalt 
bottom from the rebar depth. 
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Amp: This column shows the reflection amplitude for each pick. This information is used in creating 
deterioration plots. These values are in decibels with a correction applied for radar spreading and 
transmission. 

Dev(units): If you used automatic reflection picking with a filter length, then this column is a statistic 
that shows the deviation over a least square fit line of a defined filter length. This option is not often used 
with EZ Tracker. This value will be in whichever units were selected under View>Customize.  

% Scans: This column shows the percentage of scans within the filter length that are classified as part of 
the layer. If you have filters enabled, then this will be an indication of confidence. This option is not often 
used with EZ Tracker. 

Vel. Type: This column indicates the source of the velocity information for the pick. This is set under 
Layer Properties.  

V, or Perm: This column shows the radar wave velocity or the dielectric permittivity at the current pick 
location. You can choose to output dielectric permittivity under the Save Changes>New Filename>Save 
Options window. If you are outputting velocities, then this value will be in the vertical units selected 
under View>Customize. 

t(ns): This column shows the reflection time in nanoseconds for that pick. 
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Chapter 6: Interactive Interpretation Feature 
Overview 

All of the features in the Interactive Interpretation process that may be useful while working on a data file 
are briefly described below. 

Main Menu Options 

 
Figure 64: Main pop-up menu accessed by clicking the right mouse button when the mouse is positioned over 

data within the upper half of the Interactive Interpretation window. 

Display Gain 
The Display Gain option is found in the Main pop-up menu (accessed by right clicking in the data pane). 
Figure 65 shows the Display Gain option. 

 
Figure 65: Display Gain option selected from Main pop-up menu. 

Display Gain is the multiplication factor applied to the data to increase or decrease their display 
amplitude. It is called Display Gain because this multiplication factor will not change the data values in 
the file. 

• Clicking the left mouse button when the cursor is positioned over one of the gain values 
changes the display gain.  

• A gain of 1 is set by default.  

• Clicking on Custom allows the user to specify a different multiplier than those listed.  
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Pick Options 
Selecting Pick Options from the Main pop-up menu opens a dialog box containing the available options 
for adding and deleting picks. This process is useful for editing poor reflection picks and adding new 
picks.  

 
Figure 66: Pick Options dialog box.  

Current Focus 
There are three options for Current focus in the Bridge Assessment module – Asphalt, Rebar, or Bridge 
Bottom. The Rebar option allows the user to add single independent picks to mark objects such as pipes, 
culverts, voids, or events such as road intersections, starting and ending points of new pavement, etc. 

Current Target 
There is only 1 target name permitted in the Bridge assessment module. The default name for this target is 
“rebar”. (Other modules in RADAN permit the user to enter multiple target names with their own 
properties). 

Picking Tool 
The Picking Tool is the method employed to add and delete picks. There are four tools: (1) Single Point, 
(2) Select Block, (3) EZ Tracker, and (4) Select Range.  

Single Point 
Picks are added each time the user clicks the left mouse button and deleted each time the user clicks the 
right mouse button. Only one pick can be added at a time with this option, but multiple picks can be 
deleted depending on the Search Width. 

EZ Tracker 
EZ Tracker is designed to trace layers. It will not work for single point picking. Select the focus and click 
Start. Click on the layer and EZ Tracker will try to follow the layer by examining the amplitude values. If 
incorrect picks are made, then right click to remove the last selection. Click on Stop and Save when 
finished. 
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Select Block and Select Range 
The Select Block and Select Range picking tools are designed to operate over a large number of scans.  

Select Block 
When Select Block is activated, a multi-colored, translucent square will appear over the data when the 
user clicks the left mouse button. The select block contains tiny squares on each face and corner. These 
squares act as handles that can be used to resize the select block. 

To Resize Select Block 

1 Position the mouse cursor over one of the handles and click and hold the left mouse button. 

2 Move the mouse cursor to the desired location. 

3 When the desired size is reached, release the left mouse button.  

To Move Select Block 

1 Position the mouse cursor within the select block and click and hold the left mouse button. 

2 Move the mouse cursor until the block is in the desired position, and release the left mouse 
button. 

Select Range:  
When Select Range is activated, a multicolored translucent overlay appears over the data, extending from 
the beginning to the end of the file. It operates similarly to the Select Block, except that all operations 
performed using the Select Range picking tool are performed within the time interval (slice width) of the 
selected area on all of the scans in the file.  

• The slice width can be changed by clicking the left mouse button on one of the handles 
(located at the top and bottom of the horizontal midpoint of the slice) and with the left mouse 
button still pressed, dragging the handle to the desired location.  

• Adding and deleting points are performed within the Select Block and Select Range areas.  

• These options are activated by clicking the right mouse button while the mouse cursor is 
positioned within the multicolored Select Block or Select Range area. 

Select Block and Select Range Menu Options 
Add Points: Clicking on Add Points will activate the program to begin a smart search for reflection 
peaks within the selected region. Circles will overlay the data where reflection peaks are identified by the 
search algorithm  

Delete Points: Clicking on Delete Points will activate the program to start deleting target picks of the 
located within the selected region. 
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Pick Mod. Options:  

• Change Velocity changes the velocity of the currently selected picks located in the selected 
region. Clicking on Change Velocity opens a dialog box for entering the desired velocity. The 
new velocity is used for all of the currently selected picks. 

• Interpolate Points will interpolate target picks (add new picks between existing ones) using 
the interpolation method (Linear or Nearest Neighbor) specified in Global Options dialog, 
which is accessed from the Main Menu 

Search Width 
The search width is only applicable to the Single Point mode. Figure 67 shows the different search widths 
available. 
 

     
Figure 67: Different Search Widths indicated by the cursor size that can be used to 

add and delete picks in single point mode in Interactive Interpretation.  
The cursors correspond, from left to right, to 1 scan, 3 scans, 5 scans, 9 scans, and 17 scans. 

Save Changes 
The layer and rebar picks are stored to an ASCII file when Save Changes is selected from the Main pop-
up menu. The user has an option of saving the changes to an existing ASCII file or to a new file.  

When the user selects to save changes to a new ASCII file, the Save Options menu item can be selected. 
Figure 68 shows the save options that can be implemented to the data written to the new ASCII file. The 
various save options are described below. 

 
Figure 68: Save Options dialog box with various features that can be applied to the 

data written to a new ASCII file. 
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Output Distance Interval 
This value defines the spacing between rebar reflection picks output to the ASCII data file. For example, 
if the user selects the output distance interval to be 1.0 ft (0.3 m), and the data were obtained at a distance 
increment of 6.1 scans/ft (20 scans/m), then the pick from only 1 of the 6 scans will be output per 1 foot 
(0.3 m) increment to the ASCII file. The depth, amplitude, velocity and time values associated with the 
output pick are determined by the Interval Options (Actual, Average, Minimum or Maximum) specified 
next to each respective category.  

Selected Picks 
This sets the desired output picks. Only the selected picks will be output to the ASCII file. The only 
option for the Bridge Assessment module is Targets. 

Output Interval Options 
Only specific picks meeting the criteria specified on this line are output to the ASCII file.  

For example, if Maximum and Amplitude are chosen as the options, and the output distance interval is 1 
foot (0.3 m), the third pick in the output ASCII file will be the pick with the largest amplitude located 
between 2 and 3 feet (0.6 and 0.9 m).  

Selecting an output distance interval corresponding to the transverse rebar spacing (providing the 
transverse rebar are on top of the longitudinal rebar) and specifying Maximum and Amplitude as the 
Output Interval Options will occasionally be necessary when using the Horn Antenna Bridge Analysis 
module.  

Save only Picks at User Marks 
When this option is checked, only the picks located on scans containing user marks are saved. This option 
isn’t used often in the Bridge Assessment module.  

Convert Velocities to Permittivity 
This will output the relative dielectric permittivity at the given pick. 

Viewing and Deleting Picks Using Spreadsheet 
Selecting the Spreadsheet option from the Main pop-up menu shown in Figure 64 brings up an MS 
Excel-style spreadsheet containing the pick information contained in the ASCII database files. An 
example of the spreadsheet is shown in Figure 69. 

 
Figure 69: Pop-up spreadsheet containing rebar pick information.  

The spreadsheet is useful for viewing and deleting picks. 
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Single picks can be deleted from the spreadsheet and database by clicking on the leftmost column 
containing the row numbers to highlight the row (Figure 70), then pressing the Delete key on the 
computer keyboard. 

 
Figure 70: Highlighted row prior to being deleted. 

Target Options  
Selecting Target Options from the Main Menu allows the user to view and edit the target properties. 
Figure 71 shows the different target properties that can be modified. 

 
Figure 71: Modifiable target options that are accessed by selecting the Target Options menu item  

from the Main Menu. 

Double-clicking on the name of the target, as shown in Figure 72, opens up a dialog that permits the user 
to edit the target properties.  

 
Figure 72: Double-clicking on the target name opens up a dialog that permits the target properties to be edited. 
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Figure 73: Target Parameters dialog. 

Name: The name of the target. This name will appear in the spreadsheet and in the output ASCII file. 

Color: The color of the circle drawn at the target location in the data pane and corresponding target depth 
in the depth pane.  

Size: The size, in pixels, of the circle drawn at the target location in the data pane. 

Diameter: The diameter of the target. The width of the circle drawn in the depth pane is directly 
proportional to the target diameter when this value is greater than zero. When this value is zero, the size 
of the target circle drawn in the depth pane corresponds to the specified pixel size. 

Picking Criteria: The criteria used to pick targets in the data. The options are: (1) Positive Peak, (2) 
Negative Peak, (3) Absolute peak, and (4) None. When options 1-3 are used, the location of the target will 
correspond to a reflection peak. For option (4), the location of the target will directly correspond to the 
location of the mouse cursor or select block. 

Velocity Calc.: Sets the propagation velocity used to calculate the depth of each target. The options are: 
(1) User-specified, and (2) Core Data. To enter a user-specified option, select Specify and enter the value 
in the box next to Velocity. 

Velocity: This is the user-specified velocity. 

Lock Vel: Checking this box prevents the user from selecting a different velocity method or user-
specified velocity for individual targets within the group of targets possessing the same target name. 

Hide: Checking this box hides all the target picks from view and prevents them from being selected using 
the select block or select range picking tools. 

Link: Checking this box connects the target picks together to form pipes and other linear objects that can 
be viewed in RADAN QuickDraw This option is only available for users who have purchased the I3D 
and QuickDraw modules. 
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Global Options 
Global options are applied to all picks. Figure 74 shows the global options available with the Bridge 
Assessment Module. 

 
Figure 74: Global Parameters accessed by clicking on the Global Options item in the Main Menu. 

Single Pt. Search Length 
This option permits the user to select the search distance when adding single points. There are two 
options: (1) Closest Peak and (2) Cursor Length.  

• The Closest Peak search type will perform a search until the nearest peak is located or the 
start or end of the scan is reached. In other words, the search may potentially extend over the 
entire scan.  

• The Cursor Length search method only performs a search for a peak over the vertical length 
shown by the mouse cursor.  

• The Closest Peak method is the default option. 

Amplitude Values 
This option allows the user to specify how the amplitude values for each pick are calculated. The different 
options are: (1) Data Units, (2) dB, and (3) Normalized dB.  

• The Data Units option provides the layer bottom reflection amplitudes in the actual data 
values.  

• The dB option converts the data units amplitudes to decibels (dB) by using the equation 
20*log10(x) where x is the absolute value of the data amplitude.  

• The Normalized dB option normalizes the data amplitude relative to 32767 before converting 
to dB.  

Grid Skew Angle (degrees) 
This option corrects the GPR coordinates for bridge skew angles. All bridge deck 3-D files are initially 
created using some reference observable in the data to specify the start of the bridge. Commonly this 
reference corresponds to a joint.  

Many bridges have joints that are at non-normal angles relative to the direction of travel. Consequently, 
the GPR data coordinates must also be skewed to accurately represent correct spatial geometry of the 
bridge in the output contour map of rebar reflection amplitudes. 
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Figure 75 shows the correct way to implement skew angles. Clockwise angles are positive, counter 
clockwise angles should be negative. 

 
Figure 75: Examples of skew angles that should be put in the Grid Skew Angle category 

to convert the GPR Grid coordinates to the actual bridge coordinates. 
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Chapter 7: Using Rebar Reflection Amplitudes 
to Create Deterioration Maps 

By default, the rebar reflection amplitudes are stored in units of dB. The relative rebar reflection 
amplitude strengths have been shown to be directly correlated to bridge deck deterioration in a number of 
studies. See the references at the end of this manual for specific case studies. GSSI has found that the 
contouring and plotting package Surfer™ to be extremely flexible and easy to use for displaying rebar 
reflection amplitude contour maps.  

An example of a bridge deck condition map is shown in Figure 76. The deteriorated areas, shown in black 
in the figure, were mapped using hammer sounding once the asphalt overlay was removed from the 
concrete bridge deck. 
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Figure 76: Contour map of rebar reflection amplitudes. The black areas superimposed on the contour map 

represent areas verified to be deteriorated based on hammer sounding after the 
asphalt overlay was removed. 

The following papers are presented in their entirety in order to illustrate the most effective technique for 
creating deterioration maps. 
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BRIDGE DECK CONDITION ASSESSMENT USING GPR 
COMPARISON OF 2 GHZ HORN AND 1.5 GHZ GROUND-COUPLED ANTENNAS  

 
Robert Parrillo and Roger Roberts Ph. D. 

Geophysical Survey Systems Inc., Salem, NH 
parrillor@geophysical.com , roger@geophysical.com  

 
 

ABSTRACT 
A well established and accepted application of Ground Penetrating Radar (GPR) is the 

accurate condition assessment of bridge decks as well as other reinforced concrete structures. 
Significant advantages of using GPR for bridge deck assessment include the non-destructive 
nature of the technique; the ability of GPR to be used without requiring the removal of an 
existing asphalt overlay; and the ability to provide a quantitative record independent of 
interpretation. The most accurate bridge assessments using GPR have been performed using 
high frequency (1.5 GHz) ground-coupled antennas. The high frequency ground-coupled 
antenna provides excellent resolution of the reinforcing steel however; since the antenna must 
remain sufficiently ground-coupled it necessitates a slow data acquisition speed. Some GPR 
bridge assessments have been performed using 1 GHz air-launched horn antennas. The air-
launched antenna permits faster data collection, at the expense of resolution. In a collaborative 
effort between GSSI and the Maine DOT, both a 1.5 GHz ground-coupled antenna and GSSI’s 
2 GHz air-launched horn antenna were used to evaluate the condition of an asphalt overlaid 
bridge deck located in Lewiston, Maine. GPR data lines were acquired at two foot spacing by 
simply walking the ground-coupled antenna system and by driving a vehicle with the air-
launched horn antenna system. The GPR data was processed using GSSI’s RADAN software 
program and Bridge Assessment Module. The results were used to produce color-coded 
deterioration maps of the bridge deck. Results from the ground-coupled antenna and the air-
launched horn antenna demonstrated excellent correlation. Deterioration maps from both 
antennas were compared with visual data obtained from top-side and bottom-side visual 
inspections and exhibited excellent correlation. Correlation was further confirmed by the Maine 
DOT through hammer sounding and opening the bridge deck to expose the actual areas of 
deterioration. It was concluded that the 2 GHz air-launched horn antenna is an effective tool to 
provide an accurate assessment of the condition of bridge decks. 

 
INTRODUCTION 

The American Society of Civil Engineers reported that as of 2003, 27.1% of the nation's 
bridges (160,570) were structurally deficient or functionally obsolete (ASCE, 2003). The Federal 
Highway Administration's (FHWA's) strategic plan states that, by 2008, less than 25% of the 
nation's bridges should be classified as deficient. 

Traditional bridge deck inspection methods include hammer soundings and chain dragging. 
These familiar techniques rely on the ability of an operator to correctly and consistently interpret 
acoustical feedback to determine good and bad areas of concrete and produce an overall 
condition assessment of the deck. Existing asphalt overlays must be removed prior to using 
acoustical methods, and results can vary depending on the operator’s technique and 
determination of results. Assessment data normally consists of areas of the deck marked simply 
as good or bad.  

mailto:parrillor@geophysical.com
mailto:roger@geophysical.com
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Ground Penetrating Radar (GPR) is an accepted electromagnetic evaluation technique used 
for the transportation infrastructure and a variety of other applications, including concrete 
inspection, utility detection, geology and archeology. An established application of GPR is the 
accurate condition assessment of bridge decks as well as other reinforced concrete structures 
(Parrillo and others, 2005; Romero and others, 2000; Schongar, 2004; Romero, 2003). 

Hundreds of bridge decks have been evaluated using GPR. The most accurate bridge deck 
condition assessments using GPR have been performed using high frequency (1.5 GHz) 
ground-coupled antennas. The high frequency ground-coupled antenna provides excellent 
identification and resolution of the reinforcing steel. When performing a condition assessment of 
a bridge deck using GPR, it is common to use the relative reflections from the reinforcing steel 
(rebar) to produce deterioration maps and determine the extent of deterioration. Use of ground-
coupled antennas dictates slower data acquisition speeds since the antenna must remain 
sufficiently ground-coupled. GSSI’s BridgeScan system includes a SIR-3000 Windows CE 
based portable GPR data collection system with 1.5 GHz ground-coupled antenna. The 1.5 GHz 
antenna has a depth of penetration of approximately 18 inches in concrete, which is more than 
adequate to accurately locate the top layer of rebar. An optional small hand-cart configuration is 
available and allows the 1.5 GHz ground-coupled system to be used for applications where the 
3-wheeled push cart may not be appropriate due to size limitations (i.e. condominium 
balconies). Ground-coupled antennas may also be towed behind a vehicle at slow speeds. Dual 
channel GPR data collection systems such as GSSI’s SIR-20, may be used to collect two paths 
(channels) of data simultaneously to reduce data acquisition time. 

Vehicle-mounted 1 GHz horn antennas have been successfully used to evaluate concrete 
surface bridge decks (Maser and Bernhardt, 2000). This technique is most effective for concrete 
bridge decks with the top rebar oriented transverse to the direction of traffic. In 1998, 
Geophysical Survey Systems developed a novel technique using two vehicle-mounted 1 GHz 
air-launched horn antennas. The two antennas are mounted perpendicular to each other in a 
configuration termed “dual polarization” and are suspended approximately 18 inches (46 cm) 
above the pavement surface. With the dual polarization technique, one antenna is more 
sensitive to rebar in the transverse direction while the other antenna is more sensitive to rebar in 
the longitudinal direction. Both antennas would receive similar reflections from the planar 
interface occurring at the bottom of an asphalt overlay. Since the GPR antenna emits 
electromagnetic energy in conical shaped pattern, the energy from air-launched antenna is less 
focused when it reaches the surface of the bridge deck. The energy travels through the 
pavement surface and reaches the reinforcing steel, producing the desired reflection. As the 
result of the decreased resolution, it is normally not possible to resolve each individual rebar. 
However, a rebar “layer” may be identified and, as with the ground-coupled system, the 
reflection amplitudes are used to determine the condition of the bridge deck. When an asphalt 
overlay is present, the reflections obtained from the bottom of the asphalt may interfere and 
affect the reflection from the rebar. By subtracting the data of one 1 GHz horn antenna from the 
other (mounted perpendicular), the result is an improved dataset with minimal interference from 
randomly encountered longitudinal steel reflections and planar interfaces.  

In 2003 Geophysical Survey Systems developed a 2 GHz air-launched horn antenna that 
provides vertical resolution sufficient to distinguish the reflections from the asphalt-concrete 
interface and the top layer of reinforcing in asphalt overlaid bridge decks. This development 
potentially meant that bridge deck assessment could be accomplished using a single horn 
antenna. However, this antenna needed to be evaluated on existing bridge decks. In a 
collaborative effort between Geophysical Survey Systems and the Maine Department of 
Transportation, both the 1.5 GHz ground-coupled antenna and the 2 GHz air-launched horn 
antenna were used on April 13th, 2005 to evaluate the condition of an asphalt overlaid bridge 
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deck located in Lewiston, Maine known as the Ramp D from Main Street over Maine Central 
Railroad Bridge. Ramp D is a portion of the Veterans Memorial Bridge which crosses the Maine 
Central Railroad and the Androscoggin River (see Figures 1 and 2). 
 

 
Figure 1. Location of Bridge Deck 

 
Figure 2. Bridge Deck Photos 

 
Constructed in 1971, the deck is a 9 inch reinforced structural concrete slab and measures 

approximately 32 feet wide by 180 long. A 2 inch concrete cover was specified above the 
reinforcing steel. The hot bituminous wearing surface was replaced in 1991. A variety of repairs 
were performed and some are evident as patches in the deck surface (see Figure 3). The Maine 
DOT suspected the deck was considerably deteriorated and had scheduled the bridge for 
repair. Consequently, this particular bridge deck presented the DOT with an excellent 
opportunity for evaluating the GPR technique.  
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Figure 3. Repaired area and nearby cracked asphalt 

 
In addition to collecting GPR data, visual inspections were performed on both the topside 

and bottom-side of the bridge deck. The locations of cracking and patching on the topside and 
locations of cracking, rusting, and efflorescence on the bottom-side were recorded (see Figure 
4). This data was used to create top-side and bottom-side maps of the defects for comparison 
with the GPR data. 
 

Figure 4. Bottom-side pictures 
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The following four sections of the paper consist of descriptions of the ground-coupled and 
air-launched antenna data collection and processing methodology. These sections are followed 
by an overview of the data analysis approach, which is consistent for data collected by both the 
air-launched and ground-coupled antennas. The paper concludes with a side-by-side 
comparison of the bridge deck deterioration assessment maps produced by these two 
approaches. 
 
DATA COLLECTION – 1.5 GHZ GROUND-COUPLED ANTENNA 

For a bridge deck condition assessment project, GPR data is typically collected in the 
direction perpendicular to the upper most rebar orientation. Thus, if the upper rebar orientation 
is transverse, then the data would be collected in the direction of traffic. If the orientation of the 
rebar is unknown, it can easily be determined with by acquiring sample GPR data in both 
directions and then simply comparing the arrival times of the rebar reflections in the data. 

Design plans for the Ramp D bridge deck indicated that the upper rebar was in the 
transverse orientation. This was quickly confirmed by using the BridgeScan system to acquire 
data in both directions and comparing the arrival times of the rebar targets. 

GPR data along the bridge deck is normally collected in parallel lines approximately 2 feet 
apart. Since the upper rebar was transverse, 14 data files were collected in lines parallel to the 
direction of traffic starting 4 feet from the edge of the bridge deck (2 feet from the traveling lane 
curb) and continuing to 30 feet from the edge of the bridge deck (28 feet from the traveling lane 
curb) (see Figure 5). 

 
Figure 5. Data collection – 1.5 GHz ground-coupled antenna 

 
Data was collected at a density of 24 scans per foot or one scan every half inch. This data 

density was sufficient to clearly image the individual rebar locations, which varied from 6 inch 
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spacing to 1 foot spacing and back to 6 inch spacing along the width of the bridge deck. The 
data collection process was completed in less than one hour. 

Rebar appear in the GPR data as small hyperbolas. These hyperbolas occur because the 
antenna transmits energy in a conical pattern, and consequently, receives reflections from the 
rebar at decreasing two-way travel times as it approaches the rebar, then increasing two-way 
travel times after the antenna passes over the rebar. Rebar locations were evident in the 
unprocessed data as well as obvious areas of deterioration where rebar reflections were weak. 
Areas of the bridge deck exhibiting weak reflection amplitude values are typically indicative of 
deterioration. These weaker reflections can be due to several factors, including elevated 
chloride content, concrete degradation or corrosion of the rebar, which all attenuate the radar 
signal (see Figure 6). 
  

 
Figure 6. Unprocessed GPR data 6 feet from curb (Ground Coupled Antenna) 

 
It should be noted that the bottom of the bridge deck is also visible in the GPR data and 

appears as a white-black-white horizontal band that can be seen at approximately 7.5 ns in the 
unprocessed data shown above in Figure 6. 

 
DATA PROCESSING – 1.5 GHZ GROUND-COUPLED ANTENNA 

Following data collection, the individual GPR data files were transferred from the 
BridgeScan system to a PC for processing. Using the RADAN Bridge Assessment Module, the 
14 individual 2D GPR files were combined into a single file. Each data point in the file is 
position-referenced relative to known bridge features, such as the traveling lane bridge curb and 
starting joint. There are three processing steps involved in creating a deterioration map from the 
3-D file. The first processing step, implemented in a semi-automated manner, performs time-
zero correction, migration, and rebar reflection mapping. The next step is interactive 
interpretation. The last step is the presentation of the deterioration data in the form of a contour 
map. From start to finish, the GPR data processing time for the Ramp D bridge deck was less 
than two hours. Each important task performed during the data processing is described below. 

Rebar  Asphalt Bottom 
Areas of Deterioration 
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Time-Zero Correction 
The first step in data processing is to shift each scan of data so that the top of the scan 

corresponds to the surface of the bridge deck. This step is typically referred to as the time-zero 
correction. 
Migration 

Migration is a mathematical hyperbolic summation process that collapses hyperbolic 
diffractions associated with the rebar locations and focus on their subsurface position (see 
Figure 7).  
 

Migrated 
Rebar

Bridge
Joint

Area of 
Deterioration

 
Figure 7. Processed GPR data (Ground Coupled Antenna) 

 
Automatic Rebar Reflection Mapping 

The migration process provides data containing rebar reflections that are typically easily 
detected using automated algorithms. The algorithm implemented for deterioration mapping 
locates each rebar reflection and records its spatial location in the bridge deck along with the 
amplitude of the rebar reflection. These values are written to an ASCII comma-separated value 
(CSV) file.  
 
Interactive Interpretation 

The user will normally want to view the performance of the automatic rebar reflection-picking 
algorithm. In many instances, the rebar reflection picks will need to be edited. This may occur, 
for example, when the bridge deck is very deteriorated and the reflections from the rebar are 
very weak. During the interactive interpretation process, circular markers overlain on top of the 
GPR data indicate the located rebar reflections (see Figure 8). 
 



Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 71 

 
Figure 8. Interactive interpretation process 

 
Contouring 

Using a contour mapping program, such as Surfer from Golden Software, or DPolt from 
HydeSoft Computing, the X, Y, and reflection amplitude data for each rebar location are 
imported from the ASCII CSV file and used to create a color-coded contour map of the bridge 
deck. Weaker rebar reflections were mapped as “hotter” colors to indicate the areas of the 
bridge deck suspected of greater deterioration (see Figure 9). 
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Figure 9. Deterioration Map of Bridge Deck (Ground-coupled Antenna) 
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DATA COLLECTION – 2 GHZ AIR-LAUNCHED HORN ANTENNA 
The 2 GHz air-launched horn antenna was attached to the rear of a van using a universal 

antenna mount. The bottom of the antenna was positioned approximately 17 inches (43 cm) 
from the pavement surface. A wheel-mounted Distance Measuring Instrument (DMI) was 
attached to the rear wheel of the vehicle to provide incremental distance information to the radar 
control unit. The antenna and DMI were connected to a GSSI SIR-20 dual channel radar control 
unit mounted inside the vehicle (See Figure 10). 

First, a metal plate data file (“Bumper Jump”) was obtained for the horn antenna. This file 
captures reflections from a metal plate placed on the road surface under the antenna. Jumping 
up and down on the rear of the vehicle allows metal plate reflections to be recorded at different 
heights that the antenna may experience during data collection. This file is later processed in 
RADAN to produce a horn antenna calibration file that is used to calculate the radar wave 
velocity of the first layer of pavement. Velocities for subsequent layers are calculated in a similar 
manner. (A detailed description of the technique used for horn antenna calibration and data 
processing is available in Geophysical Survey Systems Handbook for GPR Inspection of Road 
Structures.) Thirteen data files were collected in lines parallel to the direction of traffic starting 6 
feet from the edge of the bridge deck (4 feet from the traveling lane curb) and continuing to 30 
feet from the edge of the bridge deck (28 feet from the traveling lane curb). 
 

 
Figure 10. Data collection using the 2 GHz horn antenna 

 
Data was collected at a density of 12 scans per foot, or one scan every inch. This data 

density was sufficient to clearly image the rebar layer. The data collection process was 
completed in less than one hour. 

Since the horn antenna is suspended approximately 17 inches above the ground surface, 
the energy transmitted from antenna is less focused as it reached the surface of the pavement 
and travels to the rebar. Consequently, rebar from the 2 GHz air-launched horn antenna appear 
in the GPR data as a layer rather than the individual hyperbolas produced with the ground-
coupled antenna. (See Figure 11) 
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Figure 11. Unprocessed 2 GHz horn antenna data 

 
DATA PROCESSING – 2 GHZ AIR-LAUNCHED HORN ANTENNA 

Following data collection, the individual GPR data files were processed by first, applying the 
metal plate calibration file. Applying the metal plate calibration file performs two important 
processing steps. A ring down removal filter is applied to eliminate horizontal features such as 
ringing in the data and a calibration plate scan subtraction is performed to remove coherent 
clutter in the data. The calibration scan obtained at the height most closely matching the data 
scan is selected. The peak amplitude of the calibration plate scan is then normalized relative to 
the peak amplitude of the data scan and subtracted from the data scan starting at the peak of 
the pavement reflection and continuing downward to the bottom of the scan. 

Next, the 13 individual 2D files were combined into a single 3D file (similar to the process 
described for the ground-coupled antenna processing). The next step is an interactive 
interpretation process where the rebar layer is identified. This is accomplished by opening the 
3D file in the Interactive Interpretation Mode, then using an innovative processing tool called EZ 
Tracker to identify the rebar layer. Using the mouse, the cursor is placed at the start of rebar 
layer and clicked to identify the first point on the layer. Then, the cursor is moved to right and a 
second point on the layer identified by clicking. The layer is then created by connecting the two 
points using an algorithm with criteria of searching for successive positive reflections and 
conforming to a best-fit line. This process is repeated by continuing to position the cursor on the 
rebar layer and select additional points. The created layer may be edited if necessary using 
other picking tools available in Interactive Interpretation. Other layers (i.e. bottom of the asphalt 
or bottom of the bridge deck) may also be identified in the same manner however, the polarity 
criteria may not always be positive. For example, when defining the bottom of the bridge deck, a 
negative polarity would be specified (see Figure 12). 
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Figure 12. Identifying the rebar layer in Interactive Interpretation 

 
As previously described for the ground-coupled antenna, the last step is the presentation of 

the deterioration data (X & Y location and corresponding reflection amplitude) in the form of a 
contour map (See Figure 13). From start to finish, the GPR data processing time for the Ramp 
D bridge deck was less than two hours. 
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Figure 13. Deterioration Map of Bridge Deck (Air-launched Antenna) 

 
ANALYSIS AND INTERPRETATION 

The weaker rebar reflections indicated by the “hot” colors observed in Figures 9 and 13 can 
be due to several factors including elevated chloride content, concrete degradation and/or 
corrosion of the rebar, which all attenuate the radar signal. Areas of moderate to severe 
deterioration are visible in raw GPR data as it is being collected. This was clearly evident on the 
Ramp D bridge deck as the GPR data was acquired near the center line of the deck. 

However, it is important to note an estimate of the amount of deterioration should not be 
determined by merely considering colors on the contour map. Indeed, a GPR evaluation of a 
new bridge deck will contain some range in rebar reflection amplitudes that are associated with 
rebar at different depths. It is more important to consider the total range of rebar reflection 
amplitudes when assessing the quantity of deterioration on a bridge deck. 

As the bridge ages, deterioration mechanisms selectively attack portions of the bridge deck 
that are subjected to mechanical, chemical and/or thermal stress. Mechanical stress could be 
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associated with loading and unloading from traffic; chemical stress from chloride infiltration; and 
thermal stress from freeze-thaw cycles. Thus, the onset of deterioration is often localized to 
areas of the bridge-deck subject to the most stress. These areas may grow in dimension as the 
bridge ages. The rebar reflection maps produced from GPR data are useful in locating these 
areas. The areas of weakest rebar reflections in the rebar reflection maps shown in Figures 9 
and 13 do not possess sharp boundaries. Rather, there is a gradational change in amplitude. 
For this reason, it is difficult to clearly state where deterioration stops and starts from inspection 
of deterioration maps produced from GPR data alone. It is preferable to use the GPR 
deterioration maps as a tool for classifying maintenance action level required on the bridge and 
to determine the sections of the bridge deck requiring repair.  

The bridge maintenance action-level decision typically incorporates information from a 
number of sources, including inspection of the bridge deck surface, inspection of the bridge 
deck underside (if possible), deterioration maps produced by GPR (or other techniques such as 
corrosion potential, chain drag or chloride analysis), traffic control requirements for different 
types of rehabilitation, man-hour costs and budget constraints. It is in the context of determining 
a maintenance action level that the GPR deterioration maps from the Ramp D bridge deck are 
examined.  

The green, yellow and red colors in the deterioration maps shown in Figures 9 and 13 along 
the center of the bridge correspond to significant cracking in the asphalt layer on the surface of 
the bridge and evidence of cracking and corrosion from the underside inspection map. In 
addition, all of the yellow and red areas associated with other sections of the bridge deck can be 
correlated to topside or bottom side cracking or corrosion. It is clear that the bridge deck is 
significantly deteriorated beneath the cracked sections of asphalt and in many cases the 
deterioration extents through the bridge deck. 
 
COMPARISON OF 1.5 GHZ GROUND-COUPLED AND 2 GHZ AIR-LAUNCHED ANTENNAS 
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Figure 14. Data Comparisons 

 
A side-by-side comparison of the deterioration maps produced from the 2 GHz air-launched 

antenna and the 1.5 GHz ground-coupled antenna yields practically identical results. Both maps 
show the majority of deterioration located in the center of the bridge deck and strong correlation 
with both the top-side and bottom-side maps produced from visual inspection. (See Figure 14). 

The areas of deterioration in the bridge deck were further confirmed by the Maine 
Department of Transportation. The asphalt overlay was removed and hammer soundings 
performed which identified nearly the identical areas of deterioration. Later, the actual bridge 
repair was performed by removing the areas of deteriorated concrete, identifying and repairing 
damaged rebar, and replacing with new concrete (see Figure 15). 
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Figure 15. Repairing the bridge deck 

 
CONCLUSION 

Although condition assessments from additional bridge decks are required, the preliminary 
conclusion is that the 2 GHz air-launched horn antenna appears to be an effective alternative to 
the well established ground-coupled antenna approach for the condition assessment of bridge 
decks. The air-launched antenna offers the advantages of a vehicle mounted solution with faster 
data collection speeds and a safer working environment. 
 



Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 78 

REFERENCES 
 
ASCE, 2003, American Society of Civil Engineers Report Card for America’s Infrastructure. 
http://www.asce.org/reportcard/2005/page.cfm?id=22#policy  

Parrillo, R., Roberts, R.L., and Haggan, A., 2005, Bridge Deck Condition Assessment Using 
Ground Penetrating Radar, International Bridge Conference, June 13-15, 2005, Pittsburgh, PA. 

Romero, F.A., Roberts, G.E., and Roberts, R.L., 2000, Evaluation of GPR bridge deck survey 
results used for delineation of removal/maintenance quantity boundaries on asphalt-overlaid, 
reinforced concrete deck, Structural Material Technology IV, February 28-March 3, 2000, 
Technomic Publishing Co, p. 23-30. 

Schongar, G., 2004, GPR Demonstration Project on Two Steel Reinforced Concrete Bridge 
Decks, Client Report 87, Transportation Research and Development Bureau, NYSDOT, 27 p. 

Romero, F.A., New York State Department of Transportation Ground Penetrating Radar 
Demonstration on Route 378 Bridge over D&H Railroad and Route 66 Bridge over Kinderhook 
Creek, October 2003. 

Maser, K. and M. Bernhardt, Statewide Bridge Deck Survey using Ground Penetrating Radar, 
Proceedings of Structural Materials Technology IV, Atlantic City, NJ, 2000 

Perkins, A.D., Amrol, J.J., Romero, F.A., and Roberts, R.L., 2000, “DOT Specification 
Development Based on Evaluation of Ground Penetrating Radar System Performance in 
Measuring Concrete Cover (Reinforcement Depth) on New Bridge Deck Construction”, 
Structural Materials Tech. IV, Technomic Publishing Co., Lancaster, PA, p. 53-60. 

Roberts, R.L., and Romero, F.A., 1998, “High Resolution GPR Bridge Deck Evaluation 
Surveys”, Highway Applications of Engineering Geophysics with an Emphasis on Previously 
Mined Ground, Missouri DOT, Jefferson City, Missouri.  

Roberts, G., Roberts, R., and Tarussov, A., 2001, “Identifying Concrete Deterioration using 
Ground Penetrating Radar Technology”, ASNT Conference Proceedings, Columbus, OH, 
October 16-19, 2001. 

Romero, F.A., Roberts, G.E., and Roberts, R.L., 2000, “Evaluation of GPR bridge deck survey 
results used for delineation of removal/maintenance quantity boundaries on asphalt-overlaid, 
reinforced concrete deck”, Structural Materials Tech. IV, Technomic Publishing Co., Lancaster, 
PA, p. 23-30. 

http://www.asce.org/reportcard/2005/page.cfm?id=22#policy


Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 79 

Appendix A: Velocity Calibration Procedure  
The GPR data collected with the Model 5100 antenna measures the travel time of the radar waves from 
the surface of the concrete, down to the rebar and back to the surface. It is necessary to determine the 
velocity of the radar waves to calculate the depth of the rebar. This is done by drilling a calibration hole 
and measuring the vertical depth to the top of one of the rebar in the concrete.  

The location of this rebar relative to the start of the line, and the rebar depth must be accurately measured 
to ensure that the correct rebar is located in the GPR data to obtain the most accurate velocity. When 
processing the GPR data with the Bridge QA process in RADAN, the user is prompted to enter the 
location and depth of the calibration rebar. The program then automatically locates the rebar in the data 
and calculates the velocity used to process the entire file. The entire calibration process is described in 
more detail below. 

Steps for Collecting Calibration Hole Data 

1 Make sure that the survey wheel is accurately calibrated. The calibration number in the saved 
setup for the rebar data collection is good as long as the diameter of the survey wheel does not 
change.  

2 If the survey wheel shows significant signs of wearing, a recalibration may be required. To 
recalibrate the survey wheel, see the recalibration procedure in the SIR-2, SIR-10 or SIR-20 
manual. 

3 Mark the starting position of the line along which data will be collected. Place the center of the 
5100 antenna on the line. The center of the antenna corresponds to the indentation marks in either 
side of the antenna case. 

4 Collect a data file by towing the Model 5100 antenna along the line. This line is generally called a 
profile line. This type of data is called profile line data. 

5 Select a rebar location along the profile line and determine its depth via drilling. The exact 
location of the rebar should be obtained prior to drilling by scanning the Model 5100 over the 
approximate location of the rebar while watching the signal and marking the location where the 
amplitude of the reflection is the highest, or by using a handheld pachometer.  

• To use the SIR-2 or SIR-10 with the 5100 antenna for locating the exact position of the rebar, 
set the screen to Collect Data mode and watch the amplitude of the rebar reflection while 
slowly moving the 5100 antenna as shown in Figure 77. 
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(a) Away from rebar (b) Closer to rebar (c) Almost on top of rebar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(d) Over top of rebar (e) Near top of rebar (f) Away from rebar 

Figure 77: Illustration of waveform appearance as 5100 antenna crosses over a rebar.  
The center of the antenna is located over the top of the rebar in Figure A1(d). 

• Be sure to record the exact distance of the rebar relative to the start of the profile line and the 
depth to the top of the rebar relative to the concrete surface. 
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Appendix B: Troubleshooting Problems 

Problem: Extra scans are added to end of data file after the file has been opened in RADAN. 

Solution: Extra scans (black area at the end of the file or scans with zero amplitude) are added to the 
end of a data file in two cases:  

1 If RADAN crashes and the data file is open. 

2 If the data file was collected with the SIR-20.  

The only way to remove these extra scans from the data file is to use the Select and Cut options in 
RADAN. Select the black scans, then click the Cut button and save the file to a new filename. 

Problem: After running a RadBridge project, the output 3-D file contains blank gaps. 

Solution: This problem happens when the user puts RADAN in the background (behind another 
program window) while running the project. RADAN must be kept in the foreground while the project is 
running. While a project is running, don’t switch to any other application (even Explorer); and don’t try to 
adjust any parameters in RADAN, including the size of the window. 

Problem: Unable to open an existing Project (*. rpj) file in RADAN: 

Solution:  

1 None of the data files in the RADBRIDGE project can be write-protected; otherwise, they cannot 
be used by the program. Check to see if some of the data files are write-protected. If they are, use 
Explorer to change their status. 

2 The names of some of the data files or macros may have been changed. 

3 The directory path to the data files or macros in the project may have changed. 

4 See the next problem and its solution 

Problem: Unable to open a data file in RADAN: 

Solution: When a data file is opened in RADAN, a temporary file is created in the directory specified 
as the TEMP environment variable (accessed by selecting System in the Control Panel and then selecting 
the Environment dialog page).  

For example, the TEMP directory may be c:\temp. If there is not enough space in this directory to write a 
temporary RADAN file, then a message will appear in RADAN that it is unable to open the file. To solve 
this problem, increase the space on the disk containing the TEMP directory.  



Geophysical Survey Systems, Inc. Bridge Deterioration Assessment Module 
 For RADAN 6.6 

MN 43-172 Rev G 82 

Problem: RADAN crashes while trying to write a file: 

Solution: There are two possibilities: 

1 Check to make sure there is enough disk space on the disk containing the Output file path. Allow 
for at least twice the combined space taken up by the input file (*.dzt) and the *.ind file. 

2 Check to make sure the default output path exists. The output path is specified in the Customize 
menu item. See Appendix C for details on locating and setting the default output path. 
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Appendix C: How To Quick Reference 

Change Input And Output Directories 

1 To select source (i.e., input) and output directories and units, close all open data files.  

2 Choose View > Customize, as shown in Figure 78. 

 
Figure 78: Accessing the dialog to customize input and output directories 

and the unit convention used during data interpretation. 

3 A pop-up dialog will appear as shown Figure 79:  

 
Figure 79: The default source and output directories are specified in this dialog.  

All processed data will be written to the default output directory unless overridden by the user. 
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Change Distance Or Depth Units 

1 Choose View > Customize.  

2 Click the Linear Units tab (Figure 80) to select the desired vertical (i.e., depth in cm, inches, etc.) 
and horizontal (i.e., distance in meters, ft, etc.) units.  

• These selections and the selections of the source and output directories are stored between 
RADAN sessions. Therefore, it is not necessary to change these settings each time RADAN 
is run, as they will remain as default settings until they are changed. 

 
Figure 80: Customize dialog box used to specify the vertical (depth) and horizontal (distance) units in the  

output ASCII file containing the rebar locations and depths. 
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